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Реферат 
 

Объем и структура работы. Общий объем работы составляет  62 страниц, 

в том числе 26 рисунков, 3 таблиц и списка использованных источников из 6 

наименований.  

Магистерская диссертация состоит из введения, четырех глав, заключения, 

списка использованных источников и приложений. 

Ключевые слова: автоматическая система распознавание речи, 

биометрические средства аутентификации, быстрое преобразование Фурье, метод 

временных интервалов, спектр, кепстр, эталонная модель диктора, речевая 

обработка, архитектура сигнальных процессоров, оптимизация алгоритма,  

уровень надежности. 

Актуальность темы. Актуальность темы обусловлена необходимостью 

использования аутентификаций по голосу, там, где остальные методы 

аутентификации невозможны,  где нет возможности непосредственного контакта 

пользователя с аппаратурой.  

Цель работы:  Целью диссертационной работы является исследование 

методов распознавания речи, предназначенных для построения систем 

аутентификации по голосу и определение оптимизированных параметров 

процедуры аутентификации для понижения уровня ошибок распознавания. 
Объектом исследования являются алгоритмы методов распознавания речи. 

Методы исследования. В ходе решения поставленных задач в 

диссертационной работе использованы общенаучные теоретические методы 

исследования, а также экспериментальные методы. 

Полученные результаты, их новизна, практическая значимость. На 

основании выполненных исследований получены следующие результаты: 

 в рамках анализа предметной области обоснована актуальность темы 

исследования; 

 выявлены проблемы стоящие перед ASR системами;  

 на основе анализа существующих алгоритмов обоснованы два 

перспективные с точки зрения уровня допускаемых ошибок алгоритма; 

 проведено тестирование алгоритмов в среде MatLab c целью оптимизации; 

 предложена методика для простейшей аппаратной реализации системы 

распознавание голоса.  
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Мазмұндама 

 

Жұмыстың көлемі мен құрылымы. 

Жұмыстың жалпы көлемі 62 беттен тұрады, соның құрамында 26 сурет,  3 

кесте, 6 қолданылған әдебиеттер тізімі. 

Магистрлік диссертация кіріспеден, төрт бөлімнен, қорытындыдан, 

қолданылған әдебиеттер тізімінен тұрады. 

Кілттік сөздер: сөздерді автоматты анықтау жүйесі, биометриялық 

аутентификация жүйесі, лездік Фурье түрлендіруі, уақыттық интервалдар әдісі, 

спектр, кепстр, диктордың эталондық моделі, сөздік түрлендіру, сигналды 

процессолар архитектурасы, оңтайландыру алгоритмі,  сенімділік деңгейі.  

Тақырыптың өзектілігі. Бұл тақырыптың өзектілігі ол өзге жүйелерге 

қарағанда дауыс арқылы колданушының аппаратураға тиіспей 

аутентификациядан өтуі болып табылады. 

Зерттеудің мақсаты: Зерттеулердің мақсаты дауыс арқылы 

аутентификация жүйесін құру үшін, оған қатысты әдістерді зерттеу және олардың 

қателік деңгейін  төмендету.  

Зерттеу нысаны:  дауысты анықтау әдісінің алгоритмдері. 

Зерттеу әдістері.  Диссертациялық жұмыстағы қойылған есептерді шешу 

барысында дауысты анықтау әдістері зерттелді және олар өзара салыстырылды. 

Алынған нәтижелер, олардың жаңартылымы, тәжірибелік мәні.  

Жүргізілген зертеулердің барысында келесідей нәтижелер алынды: 

 зерттеулердің арқасында мұндай жүйенің өзектілігі  дәлелденді; 

 ASR жүйелерінің орындалуы үшін, қиыншылықтар туғызатын мәселелер 

анықталды; 

 қазiргi алгоритмдерді талдаудың негiзiнде, қателік жіберу деңгейі төмен екі 

үздік алгоритм таңдау себебі дәлелденді;  

 MatLab-тың көмегімен әдістерді оңтайландыру үшін зерттеулер жүргізілді; 

 қарапайым дауыс арқылы анықтау жүйесін құрастыру үшін технакалық 

құрылғылар тізімі құрастырылды.  
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Введение 

 

Раньше возможность распознавания машиной человеческой речи, у многих 

вызывало сомнение, многие думали, что такое возможно только в научной 

фантастике. В  книге “Дорога в будущее‟, Билла Гейтса (создателя Microsoft 

Corp.) говорится, что система Automatic Speaker Recognition (ASR) одна из самых 

важных инноваций для будущих компьютерных операционных систем. 

С технологической точки зрения, ASR делится на два типа: прямой ввод 

речи DVI (direct voice input) и большой словарь распознавания непрерывной речи  

LVCSR  (large vocabulary continuous speech recognition). Устройства (DVI) прежде 

всего ориентированы для управление голосовыми командами, тогда как системы 

(LVCSR) используются для заполнения формы создания документа основной 

речи. В обоих случаях технологии схожи. Системы (DVI) обычно 

конфигурируются для малых и средних библиотек (до нескольких тысяч слов) и 

могут также использовать методы для определения фразы. Используя словарь, 

программное обеспечение сканирует разговоры и создает индекс. Индекс поиска 

содержит информацию о словах, записанных в ходе разговоров. Далее система 

ищет ключевых фразы, из тех разговоров, где содержатся ключевые слова. 

С программной части преимуществом использования ASR, является 

встроенный  дополнительный канал передачи HMI (human machine interface). И 

этот функционал улучшает управление системой. Конечно, в данный момент 

разговор с машиной еще не перешел на естественный уровень, скорее всего его 

можно назвать интуитивным, но как утверждают разработчики из одной рекламы 

ASR, "Вы с рождения учились ко всему, теперь используя нашу систему не надо 

учить все". 
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Глава 1. Анализ предметной области 

  

1.1 Распознавание речи 
 

Это процесс автоматического распознавания отдельного слова, 

произнесенного определенным человеком на основе индивидуальной 

информации, с помощью речевых волн. Этот метод позволяет использовать речь, 

чтобы проверить идентификационные данные  обеспечили  управляемый доступ к 

службам или к базе данных с помощью удаленного доступа. 

Обработка сигналов и  извлечения набора функций является важным этапом 

в любой системе распознавания речи. В данный момент оптимальный набор 

функций все еще не составлен, хотя многие исследователи занимаются этим 

вопросом. Также есть много типов функций, которые оказывают значительное 

влияние на коэффициент уровня распознавания речи. В данной работе вы можете 

ознакомиться методами, с помощью которых извлекаются набор функций из 

речевого сигнала, которые можно использовать в системах распознавания речи. 

Речевую форму волн надо преобразовать на определенный тип 

параметрического представления (которые проходят на  значительно более 

низкой скорости передачи информации) для дальнейшего анализа и обработки. 

Используется широкий диапазон для того, чтобы с помощью параметров 

представить речевой сигнал распознавания голоса, такой как Linear Prediction 

Coding (LPC), Mel-Frequency Cepstrum Coefficients (MFCC) и другие. Данные 

методы относится фронтальной обработки сигналов. Среди них MFCC является, 

самым известным и популярным. И этот метод я использую в своей работе. Он 

основываются на изменении человеческого голоса с критической пропускной 

способности с помощью частотных фильтров. Где они расположены с 

интервалами линейно низких частот и с логарифмическими высокими частотами, 

чтобы получить фонетически важные характеристики речи. Также есть еще одна 

ключевая характеристика речи - квазистационарность, т.е. это - процесс, 

протекающий в ограниченной системе и распространяющийся в ней так быстро, 

что  не успевает измениться за время распространения этого процесса в пределах 

системы её состояние. 

В данной работе предлагаю создать простую, но все же полную и 

представительную автоматическую систему распознавания голоса. С 

использованием  базируемых систем биометрического распознавание речи, с 

помощью которой система давала управления доступом. Чтобы реализовать это, 

для начало сделаем сравнительное исследование методов MFCC и TDA, 

моделируя их с помощью  “Matlab 7.0”. Для реализации также использовался 

метод временного интервала. Биометрическая система основывается на 

распознавании изолированного или отдельного слова. Для этого пользователь 

произносит пароль один раз в сеансе обучения, чтобы обучить и сохранить 

функции слова доступа. Далее в сеансе тестирования пользователь произносит 

слова снова, чтобы пройти этап распознавания [1]. 
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          1.1 Классификация биометрических систем 

 

Классификация биометрических средств аутентификации делятся по 

принципу действия на три группы:  

 Статические – это биометрические характеристики человека, которые не 

изменяются во времени. 

 Динамические -  это те характеристики, которые в разный момент времени 

динамичны, то есть изменчивые и не стабильные. 

 Комбинированный – это комбинирование двух выше сказанных групп, то 

есть использование двух биопризнаков для аутентификации.  

           На рис. 1.1 – приведена схема классификации биометрических средств 

аутентификации.  

 

 
Рисунок 1.1 – Схема  биометрических средств аутентификации 

 

В настоящее время биометрические системы контроля доступа все больше 

стали применятся для проведения аутентификации, где не требуется 

непосредственного контакта пользователя с аппаратурой. Поэтому данные 

системы применимы там, где использование других методов практически 

невозможно, например, для предоставления удаленного доступа к базам данных, 

банковским счетам, вычислительным системам, системам дистанционного 

обучения которые проходят через телефонные каналы или через интернет.  

В число современных биометрических систем контроля доступа к 

информации входят системы проверки: по голосу, форме кисти руки, рисунку 

кожи пальцев, сетчатке или радужной оболочке глаза, фотографии лица, 
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термограмме лица, динамике подписи, фрагментам генетического кода и др. (рис. 

1.2). 

 

Рисунок 1.2 - Существующие технологии биометрических средств 

аутентификации 

 

Все биометрические системы характеризуются высоким уровнем 

безопасности, прежде всего потому, что используемые в них данные не могут 

быть утеряны пользователем, похищены или скопированы. В силу своего 

принципа действия многие биометрические системы пока еще отличаются 

сравнительно малым быстродействием и низкой пропускной способностью. Тем 

не менее, они представляют собой единственное решение проблемы контроля 

доступа на особо важных объектах. Там где многочисленные проблемные 

факторы препятствуют аутентификации.  

В данное время имеется большое количество алгоритмов и методов 

биометрической аутентификации. Они отличающиеся точностью, стоимостью, 

простотой использования и т.д. Однако у всех биометрических технологий 

существуют общие подходы к решению задачи идентификации пользователя. 

Стандартный алгоритм биометрической идентификации, приведен на рис. 1.3. 
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     Рисунок 1.3 -  Алгоритм биометрической аутентификации 

Как видно из представленного алгоритма биометрическая система 

распознавания устанавливает соответствие конкретных поведенческих или 

физиологических характеристик пользователя некоторому заранее заданному 

шаблону. Как правило, биометрическая система, состоит их трех основных блоков 

и конечно из базы данных (рис. 1.4). 

 
Рисунок 1.4 - Блок-схема типовой системы биометрической 

 защиты информации 

 

Так же большое применение в настоящее время нашли биометрические 

системы аутентификации, использующие идентификацию личности по отпечатку 

пальца.  

 

          1.3 Краткое содержание работы  

 

В данной работе  вы сможет ознакомиться  с речевой обработкой и узнать, 

как работает сама система. В первой главе говорится об анализе биометрических 

систем, во второй главе о системах ASR и о распознавание речевых сигналов. Так 

де описывается процесс выделения признаков, которое в общих чертах 

показывает шаги распознавание и извлечение характеристик векторов 

произнесенной речи.  
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Во второй главе рассказывается об алгоритме MFCC и 

TDA протестированный с помощью “Matlab”  со сравнительным исследованием. 

В третьей главе описывается архитектурные характеристики цифрового 

сигнального процессора TMS320C6713. В четвертой главе рассказывается о среде 

реализации проекта. В пятой главе говорится об оптимизации, которые будут 

сделаны с помощью системы ASR на DSK. Так же можно ознакомиться с 

исходным кодом в “Matlab” и в ”СИ”, для моделирования и реализации алгоритма 

распознавания речи.  

 

          1.4 Актуальность ASR 

 

Это - принципиальные средства для передачи речи, являющиеся удобным 

режимом связи с машиной. Передача речи в данное время стала более 

эффективной и устойчивой, и  это повлияла на компьютерное распознавание речи. 

Конечно с точки зрения распознавания образов, человек распознает речь через 

очень сложное взаимодействие между многими уровнями обработки, который 

использует синтаксические и семантические информации. С помощью очень 

мощной низкоуровневой классификации образцов. Но эти алгоритмы 

классификации для полного анализа недостаточны, так как надо учитывать 

многие другие формы знании, например, лингвистический, семантический и 

прагматичный, которые должны быть базированы или встроены в устройство 

распознавания. На более низком уровне представление речи, достаточно прост, 

чтобы его генерировать (т.е. набор функций, которые будут использоваться в 

классификаторе образца). У самого классификатора должна быть определенная 

степень распознавание.  

Все системы распознавания голоса содержат два основных модуля (из Рис. 

1.5): выделение признаков и соответствие функции. Выделение признаков - 

процесс, который извлекает небольшое количество данных от речевого сигнала, 

который может использоваться, чтобы сравнить индивидуальный голос 

пользователя. Функция соответствия включает фактическую процедуру, чтобы 

идентифицировать диктора, сравнивая извлеченные функции от его/ее речевого 

ввода от других известных дикторов.  

 

 
Рисунок 1.5-Идентификация диктора (обучение) 
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Рисунок 1.6 - Проверка диктора (Тестирование) 

 

Системы распознавания проходят через две фазы. Первый упомянутый 

сеанс регистрации или учебная фаза, второй это сеанс работы или фаза 

тестирования. В учебной фазе каждый зарегистрированный диктор должен 

обеспечить выборки своей речи так, чтобы система могла создать и обучать 

эталонную модель. Кроме того, в случае систем проверки диктора специфичной 

является порог вычисление из учебных выборок. Во время тестирующей фазы 

(см. рисунок 1.6) входная речь, если соответствует с сохраненной эталонной 

моделью, то решение распознавания принимается положительное. 

Распознавание речи - трудная задача, и она является все еще активной 

областью исследования. Автоматическое распознавание речи работает на основе 

предпосылки, тоесть речь показывает характеристики, которые уникальны только 

для диктора. Принципиальным источником различия является сам диктор. 

Речевые сигналы в сеансах обучения и тестирования могут значительно 

отличаться из-за многих фактов, таких как речевое изменение во времени, 

санитарные условия (например, диктор простудися), голосовой уровень 

произнощение, и т.д. Есть также другие факторы вне зависимости от диктора, 

которые представляют собой проблему для технологии распознавания речи.  

Примеру, это - акустический шум и изменения сред для записи (например, 

диктор использует телефонный аппарат). В данный момент это является очень 

важной проблемой в сфере аутентификации речи. 

Что характеризует устойчивую систему? При использовании системы 

автоматического распознавания речи (ASR) в реальной среде, пользователи 

всегда надеются, что она может достигнуть хорошего уровня распознавания, как  

это делает слуховые органы человека, который может постоянно адаптироваться к 

динамике окружающей среды, таким как фоновый шум. К сожалению, в 

настоящее время, мощности адаптации к таким условиям машины еще не 

достигли. Фактическая производительность системы распознавания речи 

улучшится, если использовать обучаемую чистую речь, поскольку несоответствия 

между учебными и тестовыми фазами уменьшится. Если точность распознавания 

станет лучше при таких условиях, то систему станет устойчивой. 

 

1.5 Система ASR  
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1.5.1  Характеристика ASR  

 

Речевая обработка состоит из исследования речевых сигналов и методов 

обработки. Сигналы обычно обрабатываются в цифровом виде, посредством чего 

речевая обработка может, изменена на цифровую обработку сигнала, так и на 

обработку естественного языка.  

Обработка голоса – это подобие  искусственного интеллекта и лингвистики. 

Оно изучает проблемы автоматизированной генерации и понимание естественных 

голосов. Системы генерации голоса преобразовывают информацию из баз данных  

компьютера на нормальный естественный голос, понимая голос, система 

преобразует выборки в более простое представления, с которыми компьютерной 

программе легче справляться. 

Речевое кодирование - это метод  сжатие речи (в код) для передачи с речью 

кодеки, которые используют обработку аудиосигнала. Он подобен сжатию 

аудиоданных, где используется психоакустика, чтобы передать только данные, 

которые относятся к человеческой слуховой системе. Например, в узкополосном 

речевом кодировании, информация  передается в полосе частот 400 Гц к 3500 Гц, 

но восстановленный сигнал все еще достаточен для разборчивости.  

Однако речевое кодирование отличается от аудио кодирования, в том, что в 

нем намного больше статистической информации о свойствах речи. Кроме того, 

некоторые аудио информации, релевантные в аудио кодировании, может быть 

ненужной в речи, кодирующих контекста. В речевом кодировании самый важный 

критерий - сохранение разборчивости  речи с ограниченной суммой переданных 

данных. 

Нужно подчеркнуть, что разборчивость речи включает в себя, помимо 

фактического содержания, также идентификационные данные диктора, эмоции, 

интонация, тембр и т.д., которые важны для совершенной разборчивости. 

Различие свойств от абстрактного понятие речи, можно объяснить как 

разборчивость абсолютным пониманием слушателя. 

Синтез речи - искусственная обработка человеческой речи. Текст к речи 

TTS(text-to-speech) система преобразовывает нормальный текст языка в речь. 

Система рендеринг это символьные лингвистические представления 

фонетической записи в речь. Синтезируемая речь может также быть создана, 

связываясь с частями зарегистрированной речью, которые сохранены в базе 

данных. Системы отличаются по размеру сохраненных речевых модулей, которая 

обеспечивает самый большой выходной диапазон. Для определенных доменов 

используется хранение слов и предложения, которые должны допускать 

высококачественный вывод. Синтезатор может включить модель речевого тракта 

и других человеческих речевых характеристик, чтобы создать абсолютный 

синтетический речевой вывод.  

Качество синтезатора речи, оценивает его подобие человеческой речи, и его 

возможностью понимание. Программа обработки текста речи позволяет людям с 

ограниченными возможностями, такими как плохим зрением или с нарушенной 

дикцией слушать  с помощью домашнего компьютера. С 1980-х годов во многих 

компьютерах в операционных систем синтезаторы речи были установлены. 
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Речевой анализ - это проблемы, которые требуют речевого анализа, они 

происходят из голосовых связок, так как это - звуковой источник который 

активно изпользуется. Однако анализ голосовых связок физически сложен. 

Расположение голосовых связок и перемещения их усложняет эффективное 

измерение. Методы обработки изображений, такие как рентгеновские лучи или 

ультразвуки не работают, потому что голосовые связки окружены хрящами, 

которые искажает качество изображения. Перемещения в голосовых связок очень 

быстрый процесс, которые проходят на  частоте между 80 и 300 Гц, таким 

образом, использование обычного видео невозможно. Только с помощью 

высокоскоростного видео можно увидеть голосовые связки, но камера должна 

быть расположена в горле, которое делает произношение слова довольно 

трудным. 

Метод  обратной фильтрации звуковых записей и EGG (electroglottographs). 

В методах фильтрации речевой звук регистрируется снаружи рта и затем 

фильтруется по математическому методу, чтобы удалить эффекты речевого 

тракта. С помощью метод можно сделать оценку формы волн импульса давления, 

который показывает пропорциональные перемещения голосовых связок. Другой 

вид обратной индикации, работает с электродами, присоединенными к голосовым 

связкам объекта. Изменения голосовых связок горла указывают обратную 

пропорциональность, когда голосовые связки касаются друг друга. И оно 

приводит к одномерной информации контактной площадки. Таким образом, ни 

обратная фильтрация, ни EGG, не могут полностью описать процесс перемещения 

горлового гортание. 

Распознавание речи это процесс, где компьютер (или другой тип машины) 

идентифицирует произнесенное слова. Этот процесс можно назвать как разговор  

с компьютером, или как он правильно распознает, что вы произносите [2]. 

 

1.5.2 Распознавание речи систем ASR  

 

Произношение – вокализация слова (голос), которые представляются  

компьютеру в виде цифровых данных. Произношение может быть как отдельным 

словом или состоять из нескольких слов, даже как многократным предложениям. 

 

 
Рисунок 1.7 - Произношение слова "hello" 
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Зависимость от диктора. Все системы разработаны индивидуально для 

определенного диктора, так же они  обычно более точны для него. В целом 

предполагают, что диктор будет говорить непротиворечивой статической речью и 

в одном темпе. Сейчас разрабатываются диктора независимые системы, которые 

ориентированы для множества дикторов. Адаптивные системы обычно 

запускаются как независимые системы и используют учебные методы, чтобы 

адаптироваться диктору, чтобы увеличить точность распознавания. 

Словарь (или словари) являются спискам слов, которые были произнесены,  

и могут быть распознаны системой. Короткие слова проще распознать 

компьютеру, естественно, большие слова труднее. В отличие от простых 

словарей, каждая запись не должна быть отдельным словом. У маленьких 

словарей может быть только 1 или 2 произношений (например, " Просыпаться"), в 

то время как очень большие словари могут иметь тысячи или более. 

Точность - это возможность устройства как она хорошо распознает 

произнесенные слова. Это включает не только правильно идентификацию 

произношение, но и ее произношение,  находящееся в словаре. В системах ASR 

точность достигает до 98%. Качество системы зависит от точности.  

Обучение речевых устройств к распознаванию, это возможность 

адаптироваться к диктору. Когда у системы есть такая возможность, она может  

самообучаться. Система ASR обучается при наличии повторении стандартных 

или общих фраз диктора, так же и корректировке его алгоритмов сравнения, 

чтобы соответствовать эталонной модели диктора. С помошью обучение 

устройство распознавания улучшает свою точность.  

Обучение может также использоваться дикторами, которые испытывают 

затруднения, произношение определенные слова. Пока диктор повторяет 

произношение, системы ASR должна адаптироваться по состоянию изменение. 

 

1.5.3 Классификация системы ASR  

 

Система распознавания речи может адаптироваться со многими  условиями, 

такими как диктора зависимое/независимое, изолированное распознавание или со 

слитной речью, для маленького/большого словаря. Системы распознавания речи 

могут быть разделены на несколько классов, по типу произношения, где есть 

возможность распознать речь. Эти классы основываются на том, что ASR должна 

определить, когда диктор начнет и закончит произношение. В системе 

большинство пакетов вписаться в один класс, в зависимости какой режим они 

используют. 

Изолированные устройства распознавания слова обычно требуют, чтобы 

место произношение было изолировано, то есть тихое. Обычно отдельные слова 

действительно требует единственного произношения только один раз. У этих 

систем есть состояния "Listen/Not-Listen", где они требуют, чтобы диктор ожидал 

между произношением слова (обычно выполнение обработки во время пауз). 

Изолированное произнесение могло бы быть лучшим решением для этого.  
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Связанные слова – это когда система подобны изолированным словам, но 

позволяют отдельному произношению быть выполненным вместе с минимальной 

паузой между ними.  

Слитное распознавание речи - это непрерывное пошаговое распознавание 

последовательном режиме применении. Устройства распознавания с 

возможностями слитной речи по архитектуре самые трудные, чтобы создать их 

нужно использовать специальные методы, чтобы определить границы 

произношений. Устройства распознавания слитной речи позволяют 

пользователям говорить почти естественно, в то время как компьютер определяет 

содержание их речей. В основном это - компьютерная диктовка.  

Непосредственная речь – это определения речи, где она должна быть 

фактической. На базовом уровне это может считаться речью, которая является 

естественным по звучанию и не репетируемая. Система ASR с непосредственной 

речевой возможностью должна быть в состоянии обработать с множество 

естественных речевых функций, такими как заикания. 

Зависимость диктора это механизмы ASR где могут быть 

классифицированы диктора зависимые и независимые. Системы диктора 

обучаются с эталонной моделью диктора, где распознавание сделается только для 

него. Очевидно, намного более сложно, чем простое распознавание диктора. 

Проблема промежуточной сложности состоит в том, что надо обучать группу 

дикторов и распознать эту речь диктора из этой группы.  

 

          1.5.4 Проблемы ASR 

 

Есть множество проблем в распознавании речи. Однако есть много 

проблем, которые были рассмотрены за прошлые несколько десятилетий, 

большинство которых все еще остается нерешенным. Основные проблемы в ASR,  

это определение границ речи. Обычно в природе границы слова четко не 

определены. Одна из распространенных ошибок в распознавании слитной речи, 

это - пропадание слов. Это происходит, когда диктор говорит слишком быстро.  

 Изменение диалектических знаков. Люди от различных частей мира 

произносят слова по-разному. Это приводит к ошибкам в ASR. 

 Большие словари. Когда число слов в базе данных большое, подобные 

звучащие слова имеют тенденцию вызывать большое количество ошибки, 

т.е. есть вероятность, что одно слово распознано как другое. 

 Шум - основной фактор в ASR. Фактически это находится в шумных 

условиях или в примерочной, акустической, что имитации настоящего 

момента механизмы ASR становятся труднее.  

 Временное различие. Темп произношение каждого диктора бывает на 

различных скоростях. 

          Но настоящий момент механизмы ASR просто не может адаптироваться к 

этому.  

 

1.5 Анализатор речи  
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Речевой анализ, также называемый фронтальным анализом или выделением 

признаков, является первым шагом в системе автоматического распознавания 

речи. Этот процесс извлечение акустических функции из форм речевых волн. 

Вывод фронтального анализа – это компактный, эффективный набор параметров, 

которые представляют акустические свойства, наблюдаемые от входных речевых 

сигналов для последующего использования акустическим моделированием.  

Есть три главных методов обработки, а именно, кодирования с линейным 

предсказанием (LPC), MEL-частот кепстральных коэффициентов (MFCC) и 

перцепционное линейное предсказания (PLP), где последние два обычно 

используются в современных системах ASR. 

Кодирование с линейным предсказанием LPC (Linear predictive coding) 

запускается, учитывая, что речевой сигнал производиться зуммером, в конце 

трубки (озвученные звуки) с добавленным шипением звуков. Несмотря на то, что 

модель - фактически он похож на действительности речевого производства. 

Голосовая щель (пространство между голосовыми связками) производит шум, 

который характеризуется его интенсивностью (громкость) и частотой (подача). 

Речевой тракт (горло и рот) формирует трубку, которая характеризуется ее 

резонансами, которые с помощью шипения и сгенерированным действием языка, 

выступов и горла вызывают форманты.  

(LPC) анализирует сигнал и удаляет эффекты речевого сигнала. Также 

оценивая интенсивность и частоту остающегося шума. Процесс удаления 

вызывают обратной фильтрацией и остающимся сигналом после того, как 

вычитанным фильтруемым смоделированным сигнальным остатком. 

Они описывают интенсивность и частоту шума остатков, которые  могут 

быть сохранены или переданы. (LPC) синтезирует речевой сигнал, инвертируя 

процесс: используя параметры шума и их остатки, чтобы создать исходный 

сигнал, используя форманты, чтобы создать фильтр через источник, приводящий 

к речи.  

Поскольку речевые сигналы меняются в зависимости от времени, этот 

процесс происходит в блоках речевого сигнала, которые вызывают фреймы, 

обычно 30 - 50 кадров в секунду поизношенную речь с хорошим сжатием. 

Коэффициенты кепстра MEL-частот. Они получены из кепстра 

представленного аудио (спектр спектра). Различие между кепстра и MEL-кепстра 

частот в MFCC, что полосы частот расположены логарифмически (в масштабе 

MEL), который близок  ответу человеческой слуховой системы, чем линейно 

расположенные с интервалами полосы частот, полученные непосредственно из 

быстрого преобразование Фурье  FFT(Fast Fourier Transform) или дискретное 

косинусное преобразование DCT(Discrete Cosine Transform). Это улучает 

обработку данных, например, со сжатием аудио. Однако в отличие от 

сонограммы, недостаток MFCC в модели, в котором не могут представлять 

выбранную громкость точнее [3].  

MFCC обычно получаются следующим образом:  

1.  Производится преобразование Фурье (оконная выборка) сигнал.  

2. Отображаются амплитуды спектра, полученные на масштабе - MEL, с 

использованием треугольных накрадывающихся окон.  
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3. Далее используется дискретное косинусное преобразование списка 

амплитуд MEL.  

4. Далее получим MFCC - амплитуды спектра. 

Перцепционное линейное предсказание, подобное анализу (LPC), 

основывается на краткосрочном спектре речи. В отличие от чистого линейного 

прогнозирующего анализа речи, перцепционное линейное предсказание (PLP) 

изменяет краткосрочный спектр речи несколькими психофизическим образом 

базируемые преобразованиями. 

Этот метод использует три этапа слушания, чтобы произвести оценку 

слухового спектра:  

(1) Спектральная способность критической полосы,  

(2) Кривая равной громкости, 

(3) Закон громкости и интенсивности.  

Слуховой спектр приближен к авто регрессивным полюсам модели. По 

сравнению со стандартным анализом линейно прогнозирующим (LP), анализ PLP 

более схож с человеческим слухом.  

 

1.6 Речевой классификатор  

 

Проблема ASR намного более сложна в научной и технической сфере, так 

называемом распознавании образов. Цель распознавания образов состоит в том, 

чтобы классифицировать весь процесс в одну из многих категорий или классов. В 

нашем случае они являются последовательностями акустических векторов, 

которые извлечены из входной речи, описанные в предыдущем разделе. Так как 

процедура классификации в нашем случае применена на извлечение функции, о 

них также могут упоминаться с соответствующими функциями.  

Современные методы соответствия функции, которые используются в 

распознавании диктора, это – DTW (Dynamic Time Warping), HMM (Hidden 

Markov Modeling) и VQ (Vector Quantization). 

Динамическое изменения во времени - это алгоритм для измерения подобия 

между двумя последовательностями, которые могут измениться во времени и по 

скорости. Например, общие черты образцов были бы обнаружены, даже если бы в 

одном видео человек шел медленно и если в другом он шел более быстро, даже 

если были ускорения и замедления в течение одного наблюдения. (DTW) 

применяется для видео, аудио и в графике. Любые данные, которые могут быть 

превращены в линейное представление, могут быть проанализированы с (DTW).  

Чтобы распознавание речи работало надо справиться с различными 

уровнями скорости произношение диктора. В целом это - метод, который 

позволяет компьютеру находить оптимальное соответствие между двумя 

данными последовательностями (например, временной ряд) с определенными 

ограничениями, т.е. последовательности изменения нелинейные, чтобы 

соответствовать друг к  другу. Этот метод выравнивания последовательности 

часто используется в скрытых моделях Маркова. 

Скрытная модель Маркова. Основной принцип здесь должен 

характеризовать слова в вероятностной модели, где фонемы способствуют слову, 



22 
 

представляют состояния HMM (Hidden Markov Modeling), в то время как 

вероятности перехода были бы вероятностью следующей произнесенной фонемы, 

где модели для слов, которые являются частью словаря, создаются в учебной 

фазе.  

В фазе распознавания, когда пользователь произносит слова, и оно 

разделяется на фонемы, это и есть (HMM). После произношения определенной 

фонемы вероятность того, чтобы она была найденной с моделей, которые были 

созданы, сравнивая его с недавно сформированной моделью. Эта цепочка от 

одной фонемы с другой продолжается, и наконец, в определенный момент 

времени у нас есть самое вероятное слово из сохраненных слов, которые произнес 

пользователь, и таким образом распознавание произойдет с помощью подбора из 

системного словаря. Такая вероятностная система была бы более эффективной, 

чем просто кепстральный анализ, поскольку это некоторая сумма гибкости с 

точки зрения того, как слова произнесены пользователями. 

Векторное квантование VQ (Vector Quantization) - это процесс 

отображающие векторы от большого векторного пространства и  конечно от  

чисел областей в пространстве. Каждую область называют кластером, а его центр 

называют центроидом. Набор всех кодовых комбинаций называют книгой 

шифров.  

В рисунке - 1.8, можно увидеть концептуальную схему. В нем показаны 

только два диктора и две размерности акустического пространства. Круги 

относятся к акустическим векторам диктора1, в то время как треугольники к 

диктора2. В учебной фазе стандартная для диктора книга шифров (VQ) 

сгенерирована для всех известных дикторов, кластеризируя его/ее учебные 

акустические векторы. Кодовые комбинации результата (центроиды) показаны  

черными кругами и черными треугольниками для диктора 1 и 2. Расстояние от 

вектора до самой близкой кодовой комбинации книги шифров называют (VQ)-

искажением. В фазе распознавания входное произношение неизвестной речи 

"квант вектора", используя каждую обучаемую книгу шифров, мы все больше 

искажаем (VQ). Соответствующий диктор книге шифров (VQ) являются самым 

маленьким общим искажением [4]. 
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Рисунок 1.8 - Концептуальная схема, иллюстрирующая векторное 

формирование книги шифров квантования. 

 

Каждый диктор отличаться от другого с помощью базируемого 

расположения центроидов. 

 

 

 

 

 

 

 

 

 

Глава 2. Алгоритм методов 

  

2.1 Предварительная обработка 

  

Входной речевой сигнал предварительно отмечается, после этого она 

искусственно усиливает частоты. Речевые сигналы, которые не установились, 

означают функцию передачи речевого тракта, которое генерирует его, изменяется 

со временем. Далее речевые сигналы структурированы с 30 мс к фреймам на 32 

мс с перекрытиями 20 мс. Потребность в перекрытии состоит в том, что 

информация может быть потеряна на границах фрейма, таким образом 

структурировать границы надо в других фреймах. Математически, 

структурирование эквивалентно умножению сигнала с рядом скольжения 

прямоугольных окон. Проблема с прямоугольными окнами состоит в том, что 
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энергия  у них значительно выше, и поэтому он может дать начало спектральной 

утечке. Во избежание этого мы используем окно Хэмминга: 

 

                                                       (2.1) 

 

2.2 Анализ MFCC 

  

MFCC обычно рассчитываются при помощи банка фильтров треугольной 

формы с центральной частотой фильтра, расположенного с интервалами 

линейных частот меньше чем 1000 Гц и логарифмически выше 1000 Гц. 

Пропускная способность каждого фильтра определена центральными частотами 

двух смежных фильтров и зависит от частотного диапазона наборами фильтров и 

числами фильтров, выбранных для проекта. Но для человеческой слуховой 

системы, у фильтров есть своя пропускная способность, которая связана с 

центральной частотой фильтра.  

Распознавание тишины: 

Это - очень важный шаг в любой системе распознавания диктора. Система 

не может управлять моментом, когда пользователь произносит любое слово. 

Именно по этой причине мы нуждаемся в шаге обнаружения тишины, который в 

основном определяет, когда пользователь фактически начал произносить слова, и 

переводит систему отсчета в данный момент. 

Работа с окнами. Следующий шаг в обработке - это окна, которые  

минимизируют неоднородности сигнала вначале и конец структуры. Они должны 

минимизировать спектральное искажение при помощи окон, чтобы сузить сигнал 

к нолю вначале и конце структуры. Мы определяем окно так: 

 

                                                                                        (2.2) 

 

где N - число образцов в каждой структуре, когда результаты мы 

воспринимаем как сигнал окон. 

                          

                                                               (2.3) 

 

Обычно окно Хэмминга используется в виде: 

 

                                             (2.4) 

 

Быстрое преобразование Фурье (FFT). Следующий шаг обработки - это  

быстрое преобразование Фурье, который преобразовывает каждую структуру 

образцов N от временного интервала в область частоты. FFT быстрый алгоритм 

осуществляющий Discrete Fourier Transform (DFT), который предназначен для  

набора образцов N {Xn}, следующим образом:  
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         Как упомянуто выше, изменение MEL частот - это по психофизическим 

исследованиям показали, что человеческое восприятие содержания частоты 

звуков для речевых сигналов не зависима от линейных шкал. Таким образом для 

каждого тона с фактической частотой f, измеренный в Hz, субъективная подача 

измерена в масштабе MEL. Масштаб MEL – частоты ниже линейного интервала 

частот 1000 Гц, а логарифмический интервал выше 1000 Гц. Ориентированная 

подача тона на 1 кГц  40 дБ выше перцепционного порога слушания, которая 

равна 1000 mels. Поэтому мы можем использовать следующую формулу, чтобы 

вычислить mels для данной частоты в Hz. Обратите внимание на то, что мы 

используем j здесь, чтобы обозначить устройство. В общем Xn –это комплексные 

числа. Получающаяся последовательность { Xn } интерпретируется следующим 

образом: нулевая частота соответствует n = 0, положительные частоты: 0 < f < 

Fs/2.  Здесь Fs- обозначает частоту выборки. Далее после этого шага, мы получем 

спектр и периодаграмму сигнала: 

                                                               (2.6) 

Этот метод моделирования спектра должен использовать набор фильтров, 

где каждый фильтр предназначен для компонента MEL - частот. У каждого 

набора фильтров есть треугольная полоса частотной характеристики и интервала, 

а также пропускная способность определенная постоянным интервалом MEL - 

частот. Таким образом, измененный спектра S состоит из выходной мощности 

фильтров, когда он является вводом. Коэффициенты значения кепстра MEL - 

обычно выбирается 20. 

Этот набор фильтров применен в частотной области, который составляет 

взятие окон треугольной формы спектра показанный из рис. 2.1. Частоты MEL 

при изменений наборов фильтров мы должны рассматривать каждый фильтр  

гистограммы из частотной области. Полезным и эффективным способом 

реализации состоит в том, что надо рассмотреть эти треугольные фильтры в 

масштабе MEL, которые действительности были бы равномерно распределены 

фильтрами. 

 
Рисунок 2.1- Набор фильтров в линейной шкале частот 
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Рисунок 2.2 - Набор фильтров в шкале частот MEL 

 

Далее мы преобразовываем журнал спектр MEL назад во времени. 

Результат вызывают частотой MEL кепстральный коэффициентами (MFCC). 

Кепстр речи обеспечивает хорошее представление локальных спектральных 

свойств сигнала для данного анализа фрейма. Поскольку коэффициенты спектра 

MEL (и так их логарифм) являются вещественными числами, мы можем 

преобразовать их во временной интервал, используя дискретное косинусное 

преобразование (DCT). Поэтому, если мы обозначаем те коэффициенты 

энергетического спектра MEL, которые являются результатом последнего шага, 

где k =1, 2, .., K. Вычислим MFCC, как: 

 
Обратите внимание на то, что мы исключаем первый компонент С0 из DCT, 

так как это представляет среднее значение входного сигнала, который переносит 

меньшую информацию. Как только у нас есть MFCC, они характеризуют 

определенное слово, которое во время обучения поэтапно меняет коэффициенты 

для слов, которые будут определены и сохранены. Во время фазы распознавания 

коэффициенты снова распределяются для произнесенного слова, и анализируются 

относительно сохраненных коэффициентов для определения надлежащих порогов 

в зависимости от уровня безопасности, требуемой для приложения. 

 

2.3 Анализ TDA 

 

Неустановившаяся в истинном смысле речь, по исследование показало, что 

это приводит к квазистационарности, т.е. за короткий период времени (между 20 

и 40 мс), его стационарные характеристики варьируется медленно во времени. 

Далее мы с помощью импликация рассматриваем такие маленькие сегменты речи, 

где есть доминирующая частота в оконном сегменте. Где он может быть 

обработан посредством кратковременного частотного анализа. Ниже приведены 

примеры, где мы используем перекрывающиеся окна временного интервала, 

чтобы ознакомится с кратковременным анализом Фурье. 
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Рисунок 2.3 - Накладывающийся окон во временном интервале  

 

Преобразование кратковременного Фурье (STFT) речевого сигнала  s(t) 

дают: 

                                                            (2.8)      

где, w (t) - функция окна продолжительности. В речевой обработке функция 

окна Хэмминга обычно используется и ее ширина, она обычно равняется 20 - 40 

мс. Мы можем S (f, t) проанализировать следующим образом: 

 

                                                                                  (2.9) 

       

где |S (f, t) | является кратковременным спектром величины, и  (f, t) =    S 

(f, t) является коротким спектром фазы времени. Наша работа основана на 

кратковременном спектре величины с применением доминирующей частоты в 

каждом перекрывающемся сегменте. 

По поводу проектирования в STFT системах возникают много вопросов. 

Например, какая функция окна w(t) должна использоваться для вычислений 

STFT. Клиновидная функция окна (Хэмминг обычно используется в речевых 

приложениях) использовалась во всех исследованиях, потому, окна дают 

положение независимому сегменту речи при поддержании плавного перехода от 

одного сегмента к другому. К какому модификатору окон свойства речи они 

должны быть стационарные [5].  

2.4 Метод MFCC  

 

Блок-схема структуры процессора MFCC на рисунке 2.4. Речевой ввод 

обычно зарегистрирован на частоте дискретизации выше 10000 Гц. Эта частота 

дискретизации была выбрана, чтобы минимизировать эффекты искажения для 

аналога. Эти выбранные сигналы могут получить все частоты до 5 кГц, которые 

покрывают большую часть звуков, которые сгенерированы людьми. Основная 

цель процессора MFCC состоит в том, чтобы имитировать поведения 

человеческих ушей. Кроме того, а не сами речевые формы волны, MFCC менее 

восприимчивы к упомянутым изменениям [6]. 
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Рисунок 2.4 Блок-схема структуры процессора MFCC 

 

Сначала мы сохраняем сигнал как 10000 демонстрационных векторов. Было 

замечено из нашего эксперимента, что фактическая произнесенная речь, 

устраняющая статические части, подошла приблизительно к 2500 выборкам, 

таким образом, при помощи простого порогового метода мы выполнили 

обнаружение тишины, чтобы извлечь фактическую произнесенную речь.  

Это то, чего мы хотели достигнуть биометрической системой речи, которая 

способна к распознаванию изолированных слов. Эти эксперименты показали, что 

почти все изолированные слова были произнесены в 2500 выборках. Когда мы 

передали этот речевой сигнал через процессор MFCC, он приходил во временном 

интервале при помощи накладывающийся окон, каждый приблизительно с 250 

выборками. Таким образом, когда мы преобразовываем это в частотную область, 

у нас просто есть приблизительно 250 значений спектра под каждым окном. Это 

подразумевало, что преобразование его к масштабу MEL будет избыточно, 

поскольку масштаб MEL линеен до 1000 Гц. Так, мы устранили блок деформации. 

Мы непосредственно использовали треугольные окна в частотной области. Мы 

получили энергию в каждом треугольном окне, сопровождаемом в DCT 

логарифме, чтобы достигнуть хорошего уплотнения в небольшом количестве 

коэффициентов, как описано в методе MFCC. 

Этот алгоритм, однако, имеет недостаток. Как объяснено ранее ключ к 

этому подходу используется в каждом треугольном окне, однако, это может не 

быть лучшим подходом. По экспериментам видно, к этому подходу не удавалось 

распознать то же слово, произнесенное по-разному. Кроме того, поскольку он 

берет суммирование в каждом треугольном окне, которое по существу дало бы 

тому же значения независимо от того, достигает ли спектр максимума в одной 

определенной частоте и падениях к нижним значениям вокруг этого или есть ли у 

этого равное распространение в окне. Это - то, почему мы решили не продолжить 

реализацию подхода MFCC.  

Моделирование было выполнено в MATLAB. Различные этапы 

моделирования были представлены в форме показанных графиков. Входной 

сигнал слитной речи, который рассматривают как пример для этого проекта, 

является словом " hello ". 
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Рисунок 2.5 - Слово "Hello", для анализа 

 

 
Рисунок 2.6 - Слово "Hello" после обнаружения шума 

 

 
Рисунок 2.7 - Слово "Hello" после работы с использованием окон Хэмминга 
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Рисунок 2.8 -Преобразование Фурье слова "Hello"  

 

 
Рисунок 2.9 - Спектр слова "Hello" после изменения verlapping 

 

2.5 Метод TDA 

 

Сущности STFT(short-time Fourier transform) должна извлечь спектр частот в 

каждом окне во временном интервале, чтобы проанализировать частоты 

доминирования в каждом окне, соответствующем различным фонемам. В нашем 

проекте, вместо того, чтобы непосредственно применить уравнение STFT, мы 

использовали окно Хэмминга, чтобы извлечь сегменты речи, и в каждом из этих 

сегментов мы использовали FFT (Fast Fourier Transform), чтобы получить 

желаемый спектр частот.  

Графики в рис.2.10 показывают пример того, как перекрывающийся 

временной интервал окна Хэмминга мог быть представлен. Пример считает окна 

Хэмминга ширины 500 выборками, который составляет приблизительно 50 мс и 

перекрытие 100 выборок, которые составили бы приблизительно 10 мс. Это было 

изменено в нашем проекте 25 ширины окон мс и перекрытия 10 мс как требуется. 
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Рисунок 2.10 - Графики перекрывающегося временного интервала окна 

Хэмминга 

 

Блок-схему смоделированной системы можно увидеть из рис.2.11. 

 
Рисунок 2.11- Блок-схема подхода временного интервала 

 

Мы рассмотрели устройство распознавания отдельного слова в нашем 

проекте, и таким образом мы выделили приблизительно 2500 выборок, которые 

представляли речевые данные. Мы протестировали систему со многими 

различными словами и нашли, что почти все слова были произнесены в 2500 

выборках, как объяснено ранее. При помощи простого порогового алгоритма, как 

объяснено в подходе MFCC мы выделили требуемые 2500 речевых выборок. 
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Теперь, с  помощью  этих выборок перекрывающие окна Хэмминга, мы получим 

различные сегменты. Графики таких окон, на схеме работы с окнами, которую мы 

использовали для проекта, состояли из 12 перекрывающихся окон Хэмминга, 

каждой продолжительности приблизительно 25 мс и перекрытие приблизительно 

10 мс как и требовалась. 

Как только эти 12 сегментов были получены, мы нашли спектр каждого 

сегмента, используя стандартный алгоритм FFT. С помощью него мы произвели 

подход временного интервала в рабочее состояние, для дальнейших работ с  

графиками спектра. Как объяснено ранее, работа с окнами во временном 

интервале помогает разделять слово к своим фонемам и вводить 

квазистационарные характеристики речи. Это подразумевает, что у сегментов 

речи под каждым окном была бы определенная доминирующая частота из-за 

квазистационарных свойств. Это четко наблюдалось во всех тестах, т.е. спектр 

сегмента под окном для определенного слова будет всегда достигать максимума 

вокруг той же частоты. Эта доминирующая характеристика частоты была ключом 

к данной работе.  

Доминирующие частоты, полученные для каждого из этих 12 окон, 

сохранены в учебной фазе. В фазе тестирования, когда пользователь снова 

произносит слово, повторяется процесс доминирующих частот для каждого 

накладывающийся окон. Далее сравнивается со значениями, сохраненными в 

учебной фазе, если определенное число соответствует, то доступ предоставлен. 

Если не доступ запрещен. 

Есть много классификаторов, которые могут использоваться, которые мы 

получили из характеристических векторов, т.е. как только мы сохранили вектор 

во время учебной фазы, и мы получаем новый вектор в фазе тестирования, и 

таким образом мы нуждаемся в методе классификации соответствие или нет.  

График извлеченных накладывающийся оконных речевых выборок, 

которые показывают различные этапы моделирования, можно увидеть из рис.2.12, 

также можно увидеть сохраненный речевой сигнал. В этом эксперименте было 

произнесено слово " hello". На рис.2.13 результат выделения требуемых 2500 

речевых выборок, вывод одного из перекрывающегося временного интервала 

окна Хэмминга. На рис.2.14 и в рис.2.16, также можно увидеть эффект 

доминирующей частоты. 

 

 
Рисунок 2.12 - Входная речь " hello " 
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Рисунок 2.13 - Извлечение 2500 речевых выборок 

 

 
Рисунок 2.14 - Вывод накладывающийся окон 

 

 
Рисунок 2.16 - Спектр частот оконного сигнала, показывающего 

доминирующую частоту 

 

Поскольку подход временного интервала оказался более эффективным и 

надлежащим, модель в  MATLAB, мы реализовали подход временного интервала 

к DSK. 
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Глава 3. Аппаратная реализация на TMS320C6713 

  

3.1 Цифровые сигнальные процессоры  

 

Для встроенных систем распознавания речи стоимость может быть 

незначительным по сравнению с общей системой  для дополнительного речевого 

модуля. С усовершенствованиями в полупроводниковых технологии появились 

много продуктов с интегральными схемами, которые используют методы 

цифровой схемы. Цифровой метод не только увеличивает устойчивость схемы, но 

и повышает экономическую эффективность, системную интеграцию и гибкость. 

Также и включает непрерывный поток абсолютно новых потребительских 

приложений, которые все более основаны на встроенные программируемые ядра 

процессора, как цифровые сигнальные процессоры Digital signal processor (DSP) и 

микросхемы Field-Programmable Gate Arrays (FPGA) и непрограммируемые 

процессоры как специализированный ICS. Есть много принципов, таких как 

гибкость, масштабируемость, возможность многократного использования, 

мобильность и короткое время разработки для выбора правильных аппаратных 

средств, для встроенного механизма распознавания речи.  

Следующее - сравнение некоторых альтернатив, доступных для цифровой 

обработки сигналов с DSP, является аппаратными средствами, примененными в 

данной работе: 

FPGA (Field-Programmable Gate Arrays)- программируемых матриц есть 

возможность того, чтобы быть реконфигурируемым в системе, предлагая 

довольно быстрое время выхода на рынок. Однако FPGA значительно более 

дорогие и обычно имеют намного более разности в мощностях, чем DSPS. Но есть 

альтернатива с использованием ASIC, чтобы выполнить определенные функции 

чрезвычайно хорошо, и может быть сделана вполне эффективным путем. Однако, 

так как ASIC не перепрограммируемые, они не могут быть изменены после 

разработки. Следовательно, каждая новая версия продукта требует модернизации 

и должна быть воспроизведена. Это – требует большое времени для выхода на 

рынок. 

Программируемый DSP. С другой стороны, программируемый DSP может 

просто изменить программу не изменяясь полностью, который значительно 

уменьшает затраты на разработку и делает подержанные дополнительные 

функции возможными с простыми загрузками кода. Кроме того, как правило, в 

режиме реального времени приложения обработки сигналов, ASIC обычно 

используются как шинные интерфейсы, в которых связующая логика и 

функциональные акселераторы для программируемой основанной на DSP 

системе. Согласно вышеупомянутому описанию во многие системах в наше 

временим, используется DSP, поскольку аппаратная платформа для нашего 

исследования довольно проста:  

 Единственный цикл умножение; 

 Производительность в реальном времени, моделирование и эмуляция;  

 Гибкость и надежность; 

 Высокая производительность системы;  
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 Приложения DSP;  

 Классическая обработка сигналов: цифровая фильтрация, адаптивная 

фильтрация, FFT, спектр;  

 Анализ;  

 Речевая обработка: речевое кодирование, речь синтезирует, 

распознавание речи, речевое улучшение, речевая почта, речевое хранение; 

 Обработка изображений: сжатие/передача изображения, 

распознавание изображения, анимация, повышение качества изображения; 

Цифровой сигнальный процессор общего назначения также используется в  

сотовой связи и потребительских товаров. Их можно встретить: в сотовых 

телефонах, факсе и вмодемах, дисководах, радио, принтерах, слуховых аппаратах, 

MP3-плеерах, телевидение высокой четкости (HDTV), цифровые фотоаппараты, и 

т.д. Эти процессоры стали предпочтительным продуктом для многих 

потребительских приложений, так как они экономически эффективные. Они 

могут обрабатывать различные задачи, так как они могут быть повторно 

запрограммированы с готовностью для различного приложения.  

DSP были очень успешны из-за разработки недорогостоящей поддержки 

программного и аппаратного обеспечения. Например, модемы и распознавание 

речи могут быть менее дорогими с использованием DSP. 

Процессоры DSP обрабатывают сигналов в реальном времени. Обработка в 

режиме реального времени требует, чтобы обработка шла с  внешним событием, 

тогда как у других в режиме реального времени нет такого ограничения 

синхронизации. Основанные на аналоге системы с дискретными электронными 

компонентами, такими как резисторы, могут быть более чувствительны к 

изменениям температуры, тогда как DSP не восприимчивы к условиями 

окружающей среды. Процессоры DSP обладают преимуществами 

микропроцессоров. Они просты в использовании, гибки, и экономичны. 

 

3.1.1 Цифровой сигнальный процессор TMS320C6713 

  

TMS320C6713 (C6713) основывается на VelociTITM, усовершенствованной 

архитектуре VLIW (длинное командное слова), которая очень хорошо подходит 

для интенсивных алгоритмов. Семейство TMS320C6x (C6x) процессоров походит 

на быстрые микропроцессоры особого назначения со специализированным типом 

архитектуры и системы команд, подходящей для обработки сигналов. Внутренняя 

память программы сконструирована так, чтобы в общей сложности все восемь 

команд могли быть выбраны каждый цикл. Например, с тактовой частотой 225 

МГц, C6713 способен к выборке восьми 32-разрядных команд каждый на который 

1/(225 МГц) или 4.44 нс. 

VLIW процессор, который выполняет каждую команду один за другим (т.е. 

не конвейерная скалярная архитектура) может использовать ресурсы процессора 

неэффективно, потенциально приводя к низкой производительности. 

Производительность может быть улучшена, выполняя различные шаги 

последовательных инструкций одновременно (это конвейерное обрабатывание), 
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или даже выполняет многоадресные команды полностью одновременно как в 

супер скалярной архитектуре. 

Эти три метода все прибывают в стоимость: увеличенная аппаратная 

сложность. Прежде, чем выполнить любые операции параллельно, процессор 

должен проверить, что у команд нет взаимозависимостей. Есть много типов 

взаимозависимостей, но простым примером была бы программа, в которой 

результат первой команды используется в качестве ввода для второй команды. 

Они не могут выполниться одновременно, и вторая команда не может быть 

выполнена перед первым. Современные процессоры используют значительные 

ресурсы, чтобы использовать эти методы, так как планирование команд должно 

быть определено динамично, поскольку программа выполняется на основе 

зависимостей. 

Подход VLIW, с другой стороны, выполняет работу параллельно на основе 

фиксированного расписания, когда программы скомпилированы. Начиная с 

определения порядка из выполнения операций (включая который операции могут 

выполниться одновременно) обработан компилятором, процессор не нуждается в 

аппаратных средствах планирования, которых выше требуют эти три метода. В 

результате центральные процессоры VLIW предлагают значительное 

вычислительную мощность с меньшим количеством аппаратной сложности (но 

большей сложностью компилятора). 

 

3.1.2 Архитектура TMS320C6713 

 

TMS320C6713 самая высокая производительность цифровой сигнальный 

процессор (DSP) с плавающей точкой: C6713  

 Восемь 32-разрядных инструкций/циклов; 

 32/64-Bit банк данных; 

 225-200 МГц (GDP) и 200-167 МГц (PYP) тактовая частота  

 4.4-, 5-, времена с 6 командными циклами;  

 1800/1350, 1600/1200 и 1336/1000 MIPS;  

 Большой периферийный набор, оптимизированный для аудио;  

 Высоко оптимизированный компилятор C/C++;  

 Работа в различных температурных условиях;  

 Усовершенствованное ядро Very Long Instruction Word (VLIW) 

TMS320C67x™ DSP;  

 Восемь Независимых Функциональных блоков:  

Два ALU (фиксированная точка)  

Четыре ALU (с плавающей и фиксированной точкой)  

Два множителя (с плавающей фиксированной точкой)  

 Архитектура загрузки и хранения с 32-разрядными регистрами 

общего назначения;   

 Собственные инструкции для IEEE 754  

 С байтовой адресацией (8, 16, 32-разрядными данными)  

 8-разрядная защита от переполнения;  
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 Архитектура памяти L1/L2; 

 4K-байт кэш данных L1P; 

 4K-байт кэш данных L1D (С 2 путями);  

 256K-байт общее количество памяти L2: 64K-байт объединенный L2 

кэширует/отображает;  

 RAM и 192K-байт дополнительный L2 отображенная RAM;  

 Режим начальной загрузки: HPI, 8,16,32-разрядная начальная загрузка 

ROM; 

 Порядок байтов: прямой порядок байтов, обратный порядок байтов;  

 32-разрядный интерфейс внешней памяти (EMIF); 

 Glueless интерфейс к SRAM, EPROM, Flash, SBSRAM и SDRAM; 

 Общее количество 512Mб адресного пространство внешней памяти;  

 Контроллер Enhanced Direct-Memory-Access (EDMA) (с 16 

независимыми каналами);  

 16-разрядный Host-Port Interface (HPI);  

 Два многоканальных аудио последовательных порта (McASPs)  

 Две независимых часов зон (1 TX и 1 RX)  

 Каждая зона часов включает:  

Программируемый генератор часов; 

Программируемый генератор синхронизации фрейма;  

Потоки TDM с 2-32 временных интервалов; 

Поддержка размера слота: 8, 12, 16, 20, 24, 28, 32 бита;  

Средство форматирования данных для побитовой обработки;  

 Большое разнообразие I2S потока битов;  

 Интегрированный передатчик интерфейса цифрового аудио (DIT) 

Поддержки:  

S/PDIF, IEC60958-1, AES 3, Форматы CP 430; 

До 16 контактов передачи; 

 Обширная проверка ошибок и восстановление;  

 Две шины межинтервальной схемы (I2C Bus™) мульти ведущее 

устройство и ведомое устройство интерфейса; 

 Два многоканальных буферизированных последовательных порта:  

Serial-Peripheral-Interface (SPI) высокоскоростной интерфейс TDM; 

Интерфейс o AC97;  

 Два 32-разрядных таймера общего назначения;  

 Специальный Модуль GPIO с 16 контактами;  

 Гибкая цепь фазовой синхронизации (PLL) основной модуль 

генератора часов; 

 IEEE 1149.1 совместимый с периферийным сканированием (JTAG);  

 208-контактный пластмассовый (сдержанный) квадрафонический 

плоский корпус PowerPAD™ (PYP) • 272-BGA пакеты (GDP и ZDP);  

 Технология CMOS;  

 3.3-вольтовый I/O, 1.2 Вт, Внутренние (GDP & PYP): 
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          3.2 Описание ядра DSP 

 

Цифровой сигнальный процессор с плавающей точкой TMS320C6713/13 

основывается на  C67x. Он может обрабатывать очень длинные командные слова 

(VLIW) (256 битов шириной), до восьми 32-разрядных команд к этим восьми 

функциональным блокам во время каждого такта. С помощью архитектуры 

VLIW, на все восемь модулей не должны предоставляться команды, если они не 

готовы выполниться. Первый бит каждой 32-разрядной команды определяет, 

принадлежит ли следующая команда тому же, выполняют пакет как предыдущую 

команду, или это быть должно выполнено в другое время, как часть следующего 

выполняемого пакета. Пакеты выборки всегда 256 битов шириной; однако, 

выполнить пакеты могут измениться по размеру. Переменная длина выполняется 

с помощью  пакета ключевого сохранения памяти функции, и этим он отличается 

от архитектуры VLIW C67. 

В CPU (central processing unit) есть  два набора функциональных блоков. 

Каждый набор содержит четыре модуля и регистровый файл. Один набор 

содержит функциональные блоки.L1.S1.M1, и.D1; другой набор содержит 

модули.D2.M2.S2, и.L2. Эти два регистровых файла,  каждый который содержит 

16 32-разрядных регистров общей сложности 32 регистров общего назначения. 

Два набора функциональных блоков, вместе с двумя регистровыми файлами, 

составляют стороны A и B CPU. Эти четыре функциональных блока на каждой 

стороне могут свободно совместно использовать 16 регистров. Кроме того, 

каждая сторона обладает единственной шиной данных, соединенной со всеми 

регистрами с другой стороны, которыми два набора функциональных блоков 

могут получить доступ к данным от регистровых файлов на противоположной 

стороне. В то время как доступ регистра функциональными блоками на той же 

стороне как регистровый файл может обслужить все модули в единственном 

такте, доступ регистра, используя регистровый файл через CPU который 

поддерживает чтение и запись за один цикл.  

Другая главная особенность CPU C67x - архитектура загрузки и хранения, 

где все команды воздействуют на регистры. Два набора данных - наименьшие 

адресуемые элементы (.D1 и.D2) ответственны за всю передачу данных между 

регистровыми файлами и памятью. Ядро TMS320C6713 показано на рис.3.1. 
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Рисунок 3.1 - Ядро TMS320C6713 

 

Система DSP содержит TMS320C6713 (C6713) цифровой сигнальный 

процессор с плавающей точкой, а также 32-разрядный кодек стерео для ввода и 

вывода, кабель универсальной синхронной шины (USB), который соединяет плату 

DSK с персональным компьютером, 5-вольтовым источником питания для платы 

DSK и ПК IBM. Плата DSK соединяется с портом USB PC через кабель USB, с 

пакетом DSK. 

 

 
Рисунок 3.2 - Система разработки DSP 
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3.3 Интерфейс DSK  

 

Реализация алгоритмов обработки: 

 Моделирование с помощью таких инструментов, как MATLAB, 

Octave Lab view 

 
 Разработка сценария в C / C + + 

 
 Использование интегрированной среды разработки (IDE) как Code 

Composer Studio (CCS) для компиляции и ссылка 

 
 Код сборки (. ASM) для кода C построен с использованием CCS и 

он загружается на целевой процессор 

 

 

3.3.2 Макет платы DSK 

 

 
Рисунок 3.3 - TMS320C6713 плата DSK (Courtesy Texas Instruments) 
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Пакет DSK содержит аппаратные, программные инструменты поддержки 

для обработки сигналов в реальном времени. Плата DSK включает цифровой 

сигнальный процессор с плавающей точкой C6713 и 32-разрядный кодек стерео 

TLV320AIC23 (AIC23) для ввода и вывода. Встроенный кодек AIC23 использует 

технологию дельты сигмы, которая обеспечивает ADC и DAC. Это соединяется с 

системными часами на 12 МГц. Переменные частоты дискретизации от 8 to 96 

кГц. Расширение платы также обеспечено на плате DSK. Два 80-контактных 

соединителя связывают внешние интерфейсы с внешней памятью.  

Плата DSK включает 16 МБ (мегабайт) синхронной динамической 

оперативной памяти (SDRAM) и 256 КБ (килобайт) флэш-памяти. Четыре 

соединителя на плате обеспечивают ввод и вывод: MIC для ввода микрофона, для 

ввода строки и для вывода строки для вывода наушника. Состояние четырех 

пользовательских dip-переключателей на плате DSK может быть считано из 

программы управления пользовательского интерфейса с обратной связью. DSK 

работает в 225 МГц. Также на DSK – есть стабилизаторы напряжения, которые 

обеспечивают 1.26Вт для ядра C6713 и 3.3 В для его памяти и периферийных 

устройств. 

 

3.3.3 AIC23 кодек 

 
Рисунок 3.4 -TMS320C6713 ИНТЕРФЕЙСЫ DSK кодека 

 

DSK использует AIC23 кодек от Texas Instruments. Стерео для ввода и 

вывода аудиосигналов. Все аналоговые сигналы кодека на микрофоне 

преобразовывают их в цифровые данные, и они же могут быть обработано с  DSP. 

Когда DSP обработал  данные, используя кодек, их можно преобразовать из  

выборки назад в аналоговые сигналы на выводах наушника, таким образом, 
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пользователь может услышать вывод. Кодек передает использование двух 

последовательных каналов - McBSP0 & McBSP1,  

• McBSP0 используется, чтобы управлять внутренними регистрами 

конфигурации кодека. 

•   McBSP1 используется, чтобы отправить и получить выборки цифрового 

аудио.  

Все аудиоданные текут через канал передачи данных. Многие данных 

поддерживаются на основе трех переменных демонстрационной ширины, 

источника синхросигнала и последовательного формата данных. 

Предпочтительный последовательный формат - режим DSP, который специально 

разработан, чтобы воздействовать с портами McBSP на DSP.  

У кодека есть системные часы на 12 МГц. Системные часы на 12 МГц 

соответствуют режиму частоты дискретизации USB, эти системы USB 

используют часы на 12 МГц так же как часы и для кодека и для контроллера USB. 

Внутренняя частота дискретизации генерирует и разделяет часы на 12 МГц, 

чтобы генерировать общие частоты, такие как 48 кГц, 44.1 кГц и 8 кГц. Частота 

дискретизации установлена регистром SAMPLERATE кодек. 
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Глава 4. Среда разработки 

 

4.1 Среда CCS 

  

CCS (Code Composer Studio) использует интегрированную среду 

проектирования IDE (integrated development environment). Для того чтобы 

включить программные инструменты. (CCS) включает инструменты для 

генерации кода, такие как компилятор “СИ”, ассемблер и компоновщик. Это 

имеет графические возможности и поддерживает отладку в реальном времени. 

Это обеспечивает простой в использовании программный инструмент, чтобы 

создать и отладить программы. Компилятор “СИ” компилирует исходную 

программу с расширением .c, чтобы произвести исходный файл блока с 

extension.asm. Ассемблер собирает an.asm исходный файл, чтобы произвести 

объектный файл машинного языка с extension.obj. Компоновщик комбинирует 

объектные файлы и библиотеки объектов, чтобы произвести исполняемый файл с 

расширением. Этот исполняемый файл представляет соединенный общий формат 

объектных файлов (COFF), основанных на Unix системах и принятый 

несколькими производителями цифровых сигнальных процессоров. Этот 

исполняемый файл может быть загружен и выполнен непосредственно на 

процессоре C6713. 

Анализ в режиме реального времени может быть выполнен, используя 

обмен данных реального времени RTDX (real-time data exchange). (RTDX) 

допускает обмен данными между ПК и узла с DSK, а также анализом в режиме 

реального времени, не останавливая процесс. Ключевая статистика и 

производительность могут контролироваться в режиме реального времени. Через 

объединенную инициативную группу команды JTAG (Joint Test Action Group) 

связь с поддержкой эмуляции на микросхеме происходит с выполнением 

программы мониторинга и управляющей программой. Плата C6713 DSK 

включает интерфейс (JTAG) через порт (USB).  

Различные файлы, с которыми обычно встречаются в среде (CCS) при 

создании системы,  

1) file.pjt: создать и разработать проект назвали файл  

2) file.c: C исходная программа  

3) file.asm: исходная программа блока, создаваемая пользователем, 

компилятором C, или линейным оптимизатором 

4) file.sa: линейная исходная программа блока. Линейный оптимизатор 

использует file.sa в качестве ввода к  

произведите программу сборки file.asm  

5) file.h: файл поддержки заголовка  

6) file.lib: файл библиотеки, такой как файл rts6700.lib библиотеки 

поддержки во время выполнения  

7) file.cmd: командный файл компоновщика, который отображает разделы 

на память  

8) file.obj: объектный файл создан ассемблером  



44 
 

9) file.out: исполняемый файл, создаваемый компоновщиком, который будет 

загружаться и работаться C6713  

процессор  

10) file.cdb: конфигурационный файл при использовании DSP/BIOS 

Процедура для Code Composer Studio DSK6713:  

1) To create New Project  

Project -> New ( file name eg: test)  

2) To create a source file  

File -> New -> Type the code (Save and give a file name eg:sum.c)  

3) To add source files to project  

Project -> Add files to project -> sum.c  

4) To add library files  

Project -> Add files to project -> dsk6713bsl.lib  

Note: Library files path - c:\ccstudio\c6000\dsk6713bsl.lib Select Object and 

Library in Type of files( *.o and *.l files)  

5) To add Configuration Database file  

File -> New -> DSP/BIOS configuration  

Select DSK6713.cdb -> Open  

Save as X.cdb in the project folder (X depends on the the first include  

file  in the main program)  

Project -> Add files to project -> Add X.cdb from the project folder  

6) To include the files  

Open c:\ccstudio\c6000\dsk6713\include  

Copy the files  

dsk6713.h &  

dsk6713_aic23.h into the project folder  

Project -> Add files to project -> Add the two files just copied  

7) Project -> Add files to project -> Xcfg.h  

8) To connect  

Debug -> Connect  

9) To Compile  

Project -> Compile  

10) To Rebuild  

Project -> Rebuild  

11) To Load program  

File -> Load Program -> Select *.out  

12) To Execute the program  

       Build -> Run 

 

4.2 Карта памяти  

 

У семейства C67xx DSP есть большое адресное пространство с байтовой 

адресацией. Код программы и данные могут быть помещены куда угодно в 

объединенном адресном пространстве. Адреса всегда 32 бита шириной. Карта 

памяти показывает адресное пространство универсальных С6713 процессоров 
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слева с определенными деталями того, что каждая область используется справа. 

По умолчанию внутренняя память находится в начале адресного пространства. 

Части внутренней памяти могут быть реконфигурированы в программном 

обеспечении как кэш L2, а не фиксированная RAM.  

Сегмент памяти IRAM выбран по умолчанию. Выбор IRAM/SDRAM 

оставляют программисту и обычно диктуют требования хранения приложения. 

Приложения реального времени как речевая обработка, обработки изображений 

обычно требует большое места для хранения, и следовательно пространственные 

ограничения IRAM требуют использования SDRAM. В этой работе используем 

IRAM/SDRAM, чтобы обработать все данные. Обычно параметры как входные 

выборки, вычисленные значения оконного демонстрационного FFT выведены в 

SDRAM.  

 
Рисунок 4.1 - Карта памяти 

 

4.2 Оптимизация алгоритма ASR  

 

Методы выделение признаков в вычислительном отношении интенсивно, 

потому что оно включает много шагов обработки сигналов, таких как работа с 

окнами, быстрое преобразование Фурье, наборы фильтров MEL-масштаба, 

дискретное косинусное преобразование и т.д. Для каждого из этих шагов 

рассмотрели различные методы приближенных вычислений. 

В данной работе мы используем окно Хэмминга, для структуры с 

фиксированной длиной N,  и нам необходимо вычислить функцию окна h(n) для 

каждой структуры. Вместо этого h (n); 0 <n < N. 
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FFT  (Fast Fourier Transform) намного более эффективно, чем оригинальное 

DFT (Discrete Fourier Transform), оно все еще требует вычисления многих 

показательных или тригонометрических функций и умножения, которое заняло 

бы больше времени для выполнения на DSP. В нашей работе мы использовали 

DIF на 256 пунктов  корень 2 FFT. Так как речь - сигнал с реальным знаком, 

каждая входная структура содержит 256 реальных элементов, которые содержит 

первую половину, т.е. 128 сложных элементов как выход FFT. Этот выход все еще 

предоставляет полную информацию, потому что у FFT реальной 

последовательности есть симметрия вокруг пункта (N/2) Найквиста и его центра. 

 

4.3 Требования к памяти  

 

Включенная система DSP ограничила ресурс памяти. Главные требования к 

памяти прибывают из хранения справочной таблицы и для банков фильтра 

предварительно вычисление параметров, таких как окон Хэмминга, частоты 

центра каждого банка фильтра и кепстра.  

В нашей работе требования к памяти только для  речевых образцов (10000 

образцов / секунду) которые должны быть первоначально сохранены и 

соответственно обработаны.  

Отобранные CCS должны  соответствует IRAM, какие не удовлетворяют 

требования хранения памяти. Таким образом, мы используем пространство 

SDRAM, чтобы сохранить параметры. Подходящие структуры были определены в 

SDRAM и в их параметрах, как: включатели, входные речевые образцы>SDRAM, 

окна Хэмминга>IRAM, величина FFT>IRAM, и для сигнала Windowed>SDRAM. 

Не желательно оценить FFT использование настраиваемых параметров и 

данных в SDRAM, таким образом, мы создали буферное пространство в IRAM, 

где входные образцы были принесены от внешней памяти и сохраненной FFT. С 

помощью него мы избавляемся от многократных внешних доступов к памяти и 

ускоряем процесс. 

Все векторы оценки после учебной фазы и для фазы испытания нам в 

дальнейшем пригодились. Было отмечено, что данные в IRAM не были 

переписаны, если мы объявили надлежащую секцию для всех наших 

необходимых данных; таким образом мы сохранили вектор в секции IRAM, таким 

образом, мы сможем сохранять данные и для фазы испытания.  

Примечание: В конце работы сможете ознакомиться с отслеживанием 

сегментов памяти и с кодами СИ. 
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Глава 5. Исходный код в Matlab 

 

5.1 Метод MFCC. Учебная фаза 

 

fs = 10000;  % Выборка частот 

t = Hammіng(4000); % Окно Хэмминга для сглаживание речевого сигнала 

w = [t ; zеrоs(6000,1)];  

f = (1:10000);  

Mel (f) = 2595 * lоg(1 + f / 700); % Линейное изменения масштаба Мel частот 

trі = triang(100);  

wіn1 = [tre ; zеrоs(9900,1)]; % перекрывания для треугольных окон  

wіn2 = [zеrоs(50,1) ; trі ; zеrоs(9850,1)]; % анализ частотной области 

wіn3 = [zеrоs(100,1) ; trі ; zеrоs(9800,1)];  

wіn4 = [zеrоs(150,1) ; trі ; zеrоs(9750,1)];  

wіn5 = [zеrоs(200,1) ; trі ; zеrоs(9700,1)];  

wіn6 =[zеrоs(250,1) ; trі ; zеrоs(9650,1)];  

wіn7 = [zеrоs(300,1) ; trі ; zеrоs(9600,1)];  

wіn8 =[zеrоs(350,1) ; trі ; zеrоs(9550,1)];  

wіn9 = [zеrоs(400,1) ; trі ; zеrоs(9500,1)];  

wіn10 = [zеrоs(450,1) ; trі ; zеrоs(9450,1)];  

wіn11 = [zеrоs(500,1) ; trі ; zеrоs(9400,1)];  

wіn12 = [zеrоs(550,1) ; trі ; zеrоs(9350,1)];  

wіn13 =[zеrоs(600,1) ; trі ; zеrоs(9300,1)];  

wіn14 = [zеrоs(650,1) ; trі ; zеrоs(9250,1)];  

wіn15 = [zеrоs(700,1) ; trі ; zеrоs(9200,1)];  

wіn16 =[zеrоs(750,1) ; trі ; zеrоs(9150,1)];  

wіn17 = [zеrоs(800,1) ; trі ; zеrоs(9100,1)];  

wіn18 = [zеrоs(850,1) ; trі ; zеrоs(9050,1)];  

wіn19 = [zеrоs(900,1) ; trі ; zеrоs(9000,1)];  

wіn20 = [zеrоs(950,1) ; trі ; zеrоs(8950,1)];  

х = wavre cоrd(1 * fs, fs, 'dоublе'); % запись и сохранение произнесенной речи 

plоt(х);  

wavplay(х);  

і = 1;  

wһіlе abs(х(і)) < 0.05                       % Обнаружение тишины 

      і = і + 1;  

еnd  

х(1 : і) = [];  

х(6000 : 10000) = 0;  

х1 = х. * w; mх = fft(х1);  

     mх = fft(х1);                                       % Преобразование частотной области 

nх = abc(mх(flооr(mеl(f)))); % Mеl изменения 

nх = nх. / mАх(nх);  

nх1 = nх. * wіn1; nх2 = 

nх. * wіn2; nх3 = nх. *  
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wіn3; nх4 = nх. * wіn4;  

nх5 = nх. * wіn5;  

nх6 = nх. * wіn6; nх7 =  

nх. * wіn7; nх8 = nх. *  

wіn8; nх9 = nх. * wіn9;  

nх10 = nх. * wіn10; nх11 =  

nх. * wіn11; nх12 = nх. * 

wіn12; nх13 = nх. *  

wіn13; nх14 = nх. * wіn14;  

nх15 = nх. * wіn15; nх16 =  

nх. * wіn16; nх17 = nх. * 

wіn17; nх18 = nх. * wіn18;  

nх19 = nх. * wіn19; nх20 =  

nх. * wіn20;  

sх1 = sum(nх1. ^ 2); % Определение энергии сигнала в каждом окне 

sх2 = sum(nх2. ^ 2); % сумма площади величины спектра 

sх3 = sum(nх3. ^ 2); sх4 =  

sum(nх4. ^ 2); sх5 =  

sum(nх5. ^ 2); sх6 =  

sum(nх6. ^ 2); sх7 =  

sum(nх7. ^ 2); sх8 =  

sum(nх8. ^ 2); sх9 =  

sum(nх9. ^ 2);  

sх10 = sum(nх10. ^ 2); sх11 =  

sum(nх11. ^ 2); sх12 = 

sum(nх12. ^ 2); sх13 =  

sum(nх13. ^ 2); sх14 =  

sum(nх14. ^ 2); sх15 =  

sum(nх15. ^ 2); sх16 =  

sum(nх16. ^ 2); sх17 =  

sum(nх17. ^ 2); sх18 =  

sum(nх18. ^ 2); sх19 =  

sum(nх19. ^ 2); sх20 =  

sum(nх20. ^ 2);  

sх = [sх1, sх2, sх3, sх4, sх5, sх6, sх7, sх8, sх9, sх10, sх11, sх12, sх13, sх14,  

         sх15, sх16, sх17, sх18, sх19, sх20];  

sх = lоg(sх);  

dх = dСt(sх);                          % Определение регистрации энергий спектра 

fіd = fоpеn('sАmplе.dАt', 'w');  

fwrіtе(fіd, dх, 'rеАl*8');        % Сохранение особенности вектора  в .dАt файл 

fСlоsе(fіd); 
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5.1.1 Фаза тестирования 

 

fs = 10000;                    % Выборка частот 

t = Hammіng(4000);      % Окно Хэмминга для сглаживание речевого сигнала  

w = [t ; zеrоs(6000,1)];  

f = (1:10000);  

mеl(f) = 2595 * lоg(1 + f / 700);   % Линейное изменения масштаба Mеl частот  

trі = triang(100);  

wіn1 = [trі ; zеrоs(9900,1)]; % перекрывания для треугольных окон  

wіn2 = [zеrоs(50,1) ; trі ; zеrоs(9850,1)]; % анализ частотной области  

wіn3 = [zеrоs(100,1) ; trі ; zеrоs(9800,1)];  

wіn4 = [zеrоs(150,1) ; trі ; zеrоs(9750,1)];  

wіn5 =[zеrоs(200,1) ; trі ; zеrоs(9700,1)];  

wіn6 = [zеrоs(250,1) ; trі ; zеrоs(9650,1)];  

wіn7 = [zеrоs(300,1) ; trі ; zеrоs(9600,1)];  

wіn8 = [zеrоs(350,1) ; trі ; zеrоs(9550,1)];  

wіn9 = [zеrоs(400,1) ; trі ; zеrоs(9500,1)];  

wіn10 = [zеrоs(450,1) ; trі ; zеrоs(9450,1)];  

wіn11 = [zеrоs(500,1) ; trі ; zеrоs(9400,1)];  

wіn12 = [zеrоs(550,1) ; trі ; zеrоs(9350,1)];  

wіn13 = [zеrоs(600,1) ; trі ; zеrоs(9300,1)];  

wіn14 = [zеrоs(650,1) ; trі ; zеrоs(9250,1)];  

wіn15 = [zеrоs(700,1) ; trі ; zеrоs(9200,1)];  

wіn16 = [zеrоs(750,1) ; trі ; zеrоs(9150,1)];  

wіn17 = [zеrоs(800,1) ; trі ; zеrоs(9100,1)];  

wіn18 =[zеrоs(850,1) ; trі ; zеrоs(9050,1)];  

wіn19 = [zеrоs(900,1) ; trі ; zеrоs(9000,1)];  

wіn20 = [zеrоs(950,1) ; trі ; zеrоs(8950,1)];  

y = wavre cord(1 * fs, fs, 'dоublе');   % Сохранение произнесенный пароли для 

идентификации 

і = 1;  

wһіlе Abc(y(і)) < 0.05     % Обнаружение тишины 

     і = і + 1;  

 еnd  

     y(1 : і) = [];  

     y(6000 : 10000) = 0;  

     y1 = y. * w;  

     my = fft(y1); % Преобразование частотной области 

     ny = abc(my(flооr(mеl(f)))); % Mеl изменения 

     ny = ny. / mАх(ny);  

     ny1 = ny. * wіn1; ny2 = 

     ny. * wіn2; ny3 = ny. *  

    wіn3; ny4 = ny. * wіn4; 

     ny5 = ny. * wіn5; ny6 = 

     ny. * wіn6; ny7 = ny. * 
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     wіn7; ny8 = ny. * wіn8; 

     ny9 = ny. * wіn9;  

     ny10 = ny. * wіn10; ny11 = 

     ny. * wіn11; 

     ny12 = ny. * wіn12;  

     ny13 = ny. * wіn13; ny14 =  

     ny. * wіn14; ny15 = ny. * 

    wіn15; ny16 = ny. * wіn16;  

    ny17 = ny. * wіn17; ny18 =  

    ny. * wіn18; ny19 = ny. * 

    wіn19; ny20 = ny. * wіn20; 

    sy1 = sum(ny1. ^ 2); sy2 = 

    sum(ny2. ^ 2); sy3 = 

    sum(ny3. ^ 2); sy4 =  

    sum(ny4. ^ 2); sy5 =  

    sum(ny5. ^ 2); sy6 =  

    sum(ny6. ^ 2); sy7 =  

    sum(ny7. ^ 2); sy8 =  

    sum(ny8. ^ 2); sy9 =  

    sum(ny9. ^ 2);  

    sy10 = sum(ny10. ^ 2); % Определение сигнала для каждого окна 

    sy11 = sum(ny11. ^ 2); % сумма площади величины спектра 

    sy12 = sum(ny12. ^ 2); sy13 =   

   sum(ny13. ^ 2); sy14 =  

   sum(ny14. ^ 2); sy15 =  

   sum(ny15. ^ 2); sy16 =  

   sum(ny16. ^ 2); sy17 =  

   sum(ny17. ^ 2); sy18 =  

   sum(ny18. ^ 2); sy19 = 

   sum(ny19. ^ 2); sy20 =  

   sum(ny20. ^ 2);  

   sy = [sy1, sy2, sy3, sy4, sy5, sy6, sy7, sy8, sy9, sy10, sy11, sy12, sy13, sy14, 

sy15, sy16, sy17, sy18, sy19, sy20];  

   sy = lоg(sy);  

   dy = dСt(sy);                    % Регистрации энергий спектра 

   fіd = fоpеn('sАmplе.dАt','r');  

   dх = frеАd(fіd, 20, 'rеАl*8');  % вектор особенности для пароля 

   fСlоsе(fіd);              % оценка учебной фазы 

   dх = dх.';  

   MSЕ=(sum((dх - dy). ^ 2)) / 20; % Определение среднеквадратической 

ошибки 

   іf MSЕ<1  

   fprіntf('\n\nАССЕSS GRANTЕD\n\n');  

   grant=wavread('grant.wАv'); % "Доступ, разрешен" 

   wavplay(grant);  



51 
 

   еlsе  

 

   fprіntf('\n\nАССЕSS DЕNІЕD\n\n');  

   Deny=wavread('Deny.wАv'); % "Доступ, запрешен" 

   wavplay(Deny);  

    еnd 

 

5.2 Метод TDА. Учебная фаза  

 

fs = 10000;  % Выборка частот 

w = Hammіng(2500); % Окно Хэмминга для сглаживание речевой структуры 

һ = Hammіng(256); % Окно Хэмминга для поиска STFT 

wіn1 = [һ ; zеrоs(2244,1)]; % Двенадцать окон для временного интервала,для 

вычисление STFT 

wіn2 = [zеrоs(200,1) ; һ ; zеrоs(2044,1)];  

wіn3 = [zеrоs(400,1) ; һ ; zеrоs(1844,1)];  

wіn4 = [zеrоs(600,1) ; һ ; zеrоs(1644,1)];  

wіn5 = [zеrоs(800,1) ; һ ; zеrоs(1444,1)];  

wіn6 = [zеrоs(1000,1) ; һ ; zеrоs(1244,1)]; 

wіn7 = [zеrоs(1200,1) ; һ ; zеrоs(1044,1)];  

wіn8 = [zеrоs(1400,1) ; һ ; zеrоs(844,1)];  

wіn9 = [zеrоs(1600,1) ; һ ; zеrоs(644,1)]; 

wіn10 = [zеrоs(1800,1) ; һ ; zеrоs(444,1)];  

wіn11 = [zеrоs(2000,1) ; һ ; zеrоs(244,1)];  

wіn12 = [zеrоs(2244,1) ; һ];  

 

fprіntf('\nҺіt введите и сохраните пароль');  

pАusе; 

х=wavre cord(1 * fs,fs,'dоublе');  

fіgurе; plоt(х);  

wavplay(х); % Обнаружение тишины 

і = 1;  

wһіlе abc(х(і)) < 0.05  % Обнаружение речевого положение сигнала 

і = і + 1;  

еnd  

х(1 : і) = [];  

х(6000 : 10000) = 0; % Извлечние 2500 образцов речи 

х(2501 : 10000) = [];  

х1 = х;  

fіgurе; plоt(х1);  

nх= х1;  

nх1 = nх. * wіn1; % Окно речевой структуры с коротким временем 

Wіndоw  

і = 1;  

wһіlе abc(nх1(і)) == 0  
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і = і + 1;  

еnd  

 

nх1(1 : і) = [];  

nх1(6000 : 10000) = 0; 

nх1(501 : 10000) = [];  

Х1 = abc(fft(nх1));  % поиск доминирующей частоты 

wһіlе Х1(і) ~= mАх(Х1)  

і = і + 1;  

еnd  

d1 = і  

nх2 = nх. * wіn2; % Окно речевой структуры для 2 ST 

Wіndоw  

і = 1;  

wһіlе abc(nх2(і)) == 0  

і = і + 1;  

еnd  

 

nх2(1 : і) = [];  

nх2(6000 : 10000) = 0; nх2(501 : 10000) = [];  

Х2 = abc(fft(nх2)); % поиск доминирующей частоты 

і = 1;  

wһіlе Х2(і) ~= mАх(Х2)  

і = і + 1;  

еnd  

d2 = і  

nх3 = nх. * wіn3;  % Окно речевой структуры для 3 ST  

Wіndоw  

і = 1;  

wһіlе abc(nх3(і)) == 0  

і = і + 1;  

еnd  

 

nх3(1 : і) = [];  

nх3(6000 : 10000) = 0; nх3(501 : 10000) = [];  

Х3 = abc(fft(nх3));  

і = 1;  

wһіlе Х3(і) ~= mАх(Х3)  

і = і + 1;  

еnd  

d3 = і  

nх4 = nх. * wіn4; % Окно речевой структуры для 4 ST  

Wіndоw  

і = 1;  

wһіlе abc(nх4(і)) == 0  



53 
 

і = і + 1;  

еnd  

 

nх4(1 : і) = [];  

nх4(6000 : 10000) = 0; nх4(501 : 10000) = [];  

Х4 = abc(fft(nх4));  % поиск доминирующей частоты 

і = 1;  

wһіlе Х4(і) ~= mАх(Х4)  

і = і + 1;  

еnd  

d4 = і  

nх5 = nх. * wіn5;  % Окно речевой структуры для 5 ST 

і = 1;  

wһіlе abc(nх5(і)) == 0  

і = і + 1;  

еnd  

 

nх5(1 : і) = [];  

nх5(6000 : 10000) = 0; nх5(501 : 10000) = [];  

Х5 = abc(fft(nх5));  

і = 1;  

wһіlе Х5(і ) ~= mАх(Х5)  

і = і + 1;  

еnd  

d5 = і  

nх6 = nх. * wіn6;  % Окно речевой структуры для 6 ST 

Wіndоw  

і = 1;  

wһіlе abc(nх6(і)) == 0  

і = і + 1;  

еnd  

 

nх6(1 : і) = [];  

nх6(6000 : 10000) = 0; nх6(501 : 10000) = [];  

Х6 = Abc(fft(nх6));  

і = 1;  

wһіlе Х6(і) ~= mАх(Х6)  

і = і + 1;  

еnd  

d6 = і  

 

х7 = nх. * wіn7; % Окно речевой структуры для 7 ST 

і = 1;  

wһіlе abc(nх7(і)) == 0  

і = і + 1;  
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еnd  

 

nх7(1 : і) = [];  

nх7(6000 : 10000) = 0; nх7(501 : 10000) = [];  

Х7 = abc(fft(nх7));  % поиск доминирующей частоты 

і = 1;  

wһіlе Х7(і) ~= mАх(Х7)  

і = і + 1;  

еnd  

d7 = і  

nх8 = nх. * wіn8; % Окно речевой структуры для 8 ST 

і = 1;  

wһіlе abc(nх8(і)) == 0  

і = і + 1;  

еnd  

 

nх8(1 : і) = [];  

nх8(6000 : 10000) = 0; nх8(501 : 10000) = [];  

Х8 = abc(fft(nх8));  

і = 1;  

wһіlе Х8(і) ~= mАх(Х8)  

і = і + 1;  

еnd  

d8 = і  

nх9 = nх. * wіn9; % Окно речевой структуры для 9 ST 

і = 1;  

wһіlе abc(nх9(і)) == 0  

і = і + 1;  

еnd  

 

nх9(1 : і) = [];  

nх9(6000 : 10000) = 0; nх9(501 : 10000) = [];  

Х9 = abc(fft(nх9));  

і = 1;  

wһіlе Х9(і) ~= mАх(Х9)  

і = і + 1;  

еnd  

d9 = і  

nх10 = nх.*wіn10; % Окно речевой структуры для 10 ST 

Wіndоw  

і = 1;  

wһіlе abc(nх10(і)) == 0  

і = і + 1;  

еnd 
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nх10(1 : і) = [];  

nх10(6000 : 10000) = 0; nх10(501 : 10000) = [];  

Х10 = abc(fft(nх10));  % поиск компонента доминирующей частоты 

і = 1;  

wһіlе Х10(і) ~= mАх(Х10)  

і = і + 1;  

еnd  

d10 = і  

nх11 = nх. * wіn11;% Окно речевой структуры для 11 ST 

і = 1;  

wһіlе abc(nх11(і)) == 0  

і = і + 1;  

еnd  

 

nх11(1 : і) = [];  

nх11(6000 : 10000) = 0; nх11(501 : 10000) = [];  

Х11 = abc(fft(nх11));  % поиск компонента доминирующей частоты 

і = 1;  

wһіlе Х11(і) ~= mАх(Х11)  

і = і + 1;  

еnd  

d11 = і  

nх12 = nх. *wіn12; % Окно речевой структуры для 12 ST 

і = 1;  

wһіlе abc(nх12(і)) == 0  

і = і + 1;  

еnd  

nх12(1 : і) = [];  

nх12(6000 : 10000) = 0; nх12(501 : 10000) = [];  

Х12 = abc(fft(nх12)); % поиск компонента доминирующей частоты 

і = 1;  

wһіlе Х12(і) ~= mАх(Х12)  

і = і + 1;  

еnd  

d12 = і  

dх = [d1, d2, d3, d4, d5, d6, d7, d8, d9, d10, d11, d12];  

fіd = fоpеn('fеАturе.dАt', 'w');  % Сохрание вектора в .dАt файл 

fwrіtе(fіd, dх, 'rеАl*8');  % сравнение в фазе тестирования 

fСlоsе(fіd);  

5.2.1 Фаза тестирования 

 

fs = 10000;  % Выборка частот 

w = Hammіng(2500); % Окно Хэмминга для сглаживание речевой структуры 

һ = Hammіng(256); % Окно Хэмминга для поиска STFT 

wіn1 = [һ ; zеrоs(2244,1)]; % Двенадцать окон для временного интервала,для 
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вычисление STFT 

wіn2 = [zеrоs(200,1) ; һ ; zеrоs(2044,1)];  

wіn3 = [zеrоs(400,1) ; һ ; zеrоs(1844,1)];  

wіn4 = [zеrоs(600,1) ; һ ; zеrоs(1644,1)];  

wіn5 = [zеrоs(800,1) ; һ ; zеrоs(1444,1)];  

wіn6 = [zеrоs(1000,1) ; һ ; zеrоs(1244,1)];  

wіn7 = [zеrоs(1200,1) ; һ ; zеrоs(1044,1)];  

wіn8 = [zеrоs(1400,1) ; һ ; zеrоs(844,1)];  

wіn9 = [zеrоs(1600,1) ; һ ; zеrоs(644,1)];  

wіn10 = [zеrоs(1800,1) ; һ ; zеrоs(444,1)];  

wіn11 = [zеrоs(2000,1) ; һ ; zеrоs(244,1)];  

wіn12 = [zеrоs(2244,1) ; һ];  

 

fprіntf('\nҺіt введите и сохраните пароль');  

pАusе;  

 

х=wavre cord(1 * fs,fs,'dоublе');  

fіgurе; plоt(х);  

wavplay(х);  

і = 1;  

wһіlе abc(х(і)) < 0.05  

і = і + 1;  

еnd  

 

х(1 : і) = [];  

х(6000 : 10000) = 0; х(2501 : 10000) = [];  

х1 = х;  

fіgurе; plоt(х1);  

nх= х1;  

nх1 = nх. * wіn1;    

і = 1;  

wһіlе abc(nх1(і)) == 0  

і = і + 1;  

еnd  

nх1(1 : і) = [];  

nх1(6000 : 10000) = 0; nх1(501 : 10000) = [];  

Х1 = abc(fft(nх1));  

wһіlе Х1(і) ~= mАх(Х1)  

і = і + 1;  

еnd  

d1 = і  

nх2 = nх. * wіn2; % Окно речевой структуры для SST 

і = 1;  

wһіlе abc(nх2(і)) == 0  

і = і + 1;  
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еnd  

nх2(1 : і) = [];  

nх2(6000 : 10000) = 0; nх2(501 : 10000) = [];  

 

Х2 = abc(fft(nх2));  

і = 1;  

wһіlе Х2(і) ~= mАх(Х2)  

і = і + 1;  

еnd  

d2 = і  

nх3 = nх. * wіn3; % Окно речевой структуры для 3 ST 

і = 1;  

wһіlе abc(nх3(і)) == 0  

і = і + 1;  

еnd  

nх3(1 : і) = [];  

nх3(6000 : 10000) = 0; nх3(501 : 10000) = [];  

 

Х3 = abc(fft(nх3));  

і = 1;  

wһіlе Х3(і) ~= mАх(Х3)  

і = і + 1;  

еnd  

d3 = і  

nх4 = nх. * wіn4; % Окно речевой структуры для 4 ST 

і = 1;  

wһіlе abc(nх4(і)) == 0  

і = і + 1;  

еnd  

nх4(1 : і) = [];  

nх4(6000 : 10000) = 0; nх4(501 : 10000) = [];  

 

Х4 = abc(fft(nх4));  

і = 1;  

wһіlе Х4(і) ~= mАх(Х4)  

і = і + 1;  

еnd  

d4 = і  

nх5 = nх. * wіn5; % Окно речевой структуры для 5 ST 

і = 1;  

wһіlе abc(nх5(і)) == 0  

і = і + 1;  

еnd  

 

nх5(1 : і) = [];  
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nх5(6000 : 10000) = 0; nх5(501 : 10000) = [];  

Х5 = abc(fft(nх5));  

і = 1;  

wһіlе Х5(і ) ~= mАх(Х5)  

і = і + 1;  

еnd  

d5 = і  

nх6 = nх. * wіn6; % Окно речевой структуры для 6 ST 

і = 1;  

wһіlе abc(nх6(і)) == 0  

і = і + 1;  

еnd  

 

nх6(1 : і) = [];  

nх6(6000 : 10000) = 0; nх6(501 : 10000) = [];  

Х6 = abc(fft(nх6));  

і = 1;  

wһіlе Х6(і) ~= mАх(Х6)  

і = і + 1;  

еnd  

d6 = і  

nх7 = nх. * wіn7; % Окно речевой структуры для 7 ST 

і = 1;  

wһіlе abc(nх7(і)) == 0  

і = і + 1;  

еnd  

 

nх7(1 : і) = [];  

nх7(6000 : 10000) = 0; nх7(501 : 10000) = [];  

Х7 = abc(fft(nх7));  

і = 1;  

wһіlе Х7(і) ~= mАх(Х7)  

і = і + 1;  

еnd  

d7 = і  

nх8 = nх. * wіn8; % Окно речевой структуры для 8 ST 

і = 1;  

wһіlе abc(nх8(і)) == 0  

і = і + 1;  

еnd  

nх8(1 : і) = [];  

nх8(6000 : 10000) = 0; nх8(501 : 10000) = [];  

Х8 = abc(fft(nх8));  % поиск компонента доминирующей частоты 

і = 1;  

wһіlе Х8(і) ~= mАх(Х8)  
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і = і + 1;  

еnd  

d8 = і  

nх9 = nх. * wіn9; % Окно речевой структуры для 9 ST 

і = 1;  

wһіlе abc(nх9(і)) == 0  

і = і + 1;  

еnd  

nх9(1 : і) = [];  

nх9(6000 : 10000) = 0; nх9(501 : 10000) = [];  

 

Х9 = abc(fft(nх9));  

і = 1;  

wһіlе Х9(і) ~= mАх(Х9)  

і = і + 1;  

еnd  

d9 = і  

nх10 = nх.*wіn10; % Окно речевой структуры для 10 ST 

і = 1;  

wһіlе abc(nх10(і)) == 0  

і = і + 1;  

еnd 

  

nх10(1 : і) = [];  

nх10(6000 : 10000) = 0; nх10(501 : 10000) = [];  

Х10 = abc(fft(nх10));  % поиск компонента доминирующей частоты 

і = 1;  

wһіlе Х10(і) ~= mАх(Х10)  

і = і + 1;  

еnd  

d10 = і  

nх11 = nх. * wіn11; % Окно речевой структуры для 11 ST 

і = 1;  

wһіlе abc(nх11(і)) == 0  

і = і + 1;  

еnd  

nх11(1 : і) = [];  

nх11(6000 : 10000) = 0; nх11(501 : 10000) = [];  

 

Х11 = abc(fft(nх11));  

і = 1;  

wһіlе Х11(і) ~= mАх(Х11)  

і = і + 1;  

еnd  

d11 = і  
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nх12 = nх. *wіn12; % Окно речевой структуры для 12 ST 

і = 1;  

wһіlе abc(nх12(і)) == 0  

і = і + 1;  

еnd  

 

nх12(1 : і) = [];  

nх12(6000 : 10000) = 0; nх12(501 : 10000) = [];  

Х12 = abc(fft(nх12));  % поиск компонента доминирующей частоты 

і = 1;  

wһіlе Х12(і) ~= mАх(Х12)  

і = і + 1;  

еnd  

 

d12 = і  

dy = [d1, d2, d3, d4, d5, d6, d7, d8, d9, d10, d11, d12];  

fіd = fоpеn('fеАturе.dАt', 'r'); dх = frеАd(fіd, 12, 'rеАl*8');  

fСlоsе(fіd);  

dх = dх.';  

і = 1; j = 0;  

wһіlе(і < 13)  

 

іf(Abc(dy(і) - dх(і)) < 5) % Проверка отклонения для доминантного признака 

j = j + 1;  % спектральные компоненты для каждого окна 

еnd  

і = і + 1;  

еnd  

іf j > 7  % Проверка чисел 

fprіntf('\n\nАССЕSS GRANTЕD\n\n');  

grant = wavread('Grant.wАv'); % "Доступ, разрещен" сохраненный в .dАt файл 

wavplay(Grant);  

еlsе  

fprіntf('\n\nАССЕSS DЕNІЕD\n\n');  

deny = wavread('deny.wАv'); % "Доступ, запрещен" сохраненный в .dАt файл  

wavplay(deny);  

еnd.  
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Глава 6. Результаты и заключения  

 

6.1 Сравнение методов  

 

Мы моделировали подход MFCC и подход временного интервала, 

используя Matlab. Из наших экспериментов мы пришли к заключению, что для 

изолированной системы распознавания слов подход временного интервала, 

оказался более эффективным. Причина этого состоит в том, что, у подхода MFCC 

есть  недостатки. Как объяснено ранее. Кроме того, достигает ли спектр 

максимума в одной определенной частоте и падениях к нижним значениям  или 

есть ли равное распространение в окне. Поскольку подход временного интервала 

основан на доминирующих частотах в маленьких сегментах речи, это хорошо 

используется в  квазистационарное свойствах речи. Таким образом, мы пришли к 

заключению от наших результатов моделирования, что подход временного 

интервала более подходит для изолированного устройства распознавания речи 

базируемой биометрической системы речи. Сравнение между алгоритма можно 

увидеть в таблицах ниже. На основе этого мы решили реализовать подход 

временного интервала к DSK. 

Метод MFCC: Следующие результаты испытаний были получены, 

моделируя базируемый метод распознавания MFCC в Matlab. Из таблицы 6.1 

можно увидеть MSE для четырех пользователей, которые протестировали 

систему. Для этого эксперимента порог MSE  был установлен 1. 

 

Таблицы 6.1 – Результаты метода MFCC  

Диктор1 Диктор2 Диктор3 Диктор4 

1,0859 0,3507 0,8546 0,9821 

0,3354 0,3983 0,6148 1,7451 

0,3288 0,4055 0,3465 0,8956 

0,8407 0,3018 2,0014 0,7998 

0,4480 0,2232 0,4269 0,9324 

0,5672 1,4045 0,3458 1,6542 

0,4181 0,3946 0,5982 0,5421 

0,5288 0,7628 0,3991 0,9654 

1,6195 0,5548 0,4651 0,6495 

0,4471 0,4912 0,8651 0,5981 

0,4887 0,6149 0,4438 0,8495 

0,3610 0,3674 0,3215 0,2136 

0,9020 0,6713 1,,3201 0,9101 

0,3661 0,2025 0,5231 0,2631 

0,5645 0,3948 0,6723 0,6498 

0,4213 0,4532 0,2132 2,2651 

0,4656 1,2063 0,3135 0,4561 

0,3263 0,2123 0,4136 0,6462 

0,9262 0,5631 1,7512 0,7412 

0,6298 0,3516 0,3212 0,6521 
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Метод TDA: Следующие результаты испытаний были получены, моделируя 

базируемый подход распознавания временного интервала в MATLAB. Записи 

указывают число доминирующих настроек по частоте, полученных для четырех 

пользователей, на которых протестировали систему. Порог 8 соответствий был 

установлен для этого эксперимента. 

 

Таблицы 6.2 – Результаты метода TDA  

Диктор1 Диктор2 Диктор3 Диктор4 

11 10 10 11 

11 12 10 8 

8 9 9 10 

10 11 11 10 

12 7 9 9 

9 10 6 5 

10 8 9 11 

8 11 10 12 

12 12 10 11 

9 9 11 9 

11 8 7 7 

6 10 8 9 

11 11 10 12 

10 10 12 11 

11 12 11 10 

10 8 9 11 

8 11 10 9 

12 12 12 11 

10 9 11 9 

11 8 9 10 

 

Результаты моделирования:  

На таблице -6.3 можно увидеть процент распознавание диктора для обоих 

алгоритмов. 

 

Таблица 6.3 - Процент распознавание для двух методов 

 

Диктор1 Диктор2 Диктор3 Диктор4 

Метод MFCC 
85% 80% 85% 80% 

Метод TDA 
90% 85% 90% 85% 
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6.1 Заключения 

 

В данной работе были проведены исследования в области существующих 

методов распознавания отдельного слова, использовались инструменты, такие как 

Matlab, была реализована система ASR  на платформе TMS320C6713 DSP. 

Эксперименты были выполнены, опираясь на данные системы реальное время 

ASR. Тесты проводились при переменных условиях, то есть при большом 

количестве дикторов (мужчин/женщин). Результаты основываются из этих же 

фактов. 

Интересным фактом из экспериментов, является, когда на методе MFCC из 

нескольких тестовых случаев не удалось справиться с поставленной задачей. Где 

отличие было очень небольшим, различие между двумя словами "h-ello " и "f-

ellow". Метод временного интервала в нашем случае, оказался более устойчивым 

при таких испытаниях. Также были проблемы при реализации на платформе 

TMS320C6713 при создании алгоритмов. Совместимых для эффективной 

реализации на DSP, относительно аспектов эффективности выполнения 

инструкции, при использовании памяти. Результаты были довольно 

удовлетворительны для рассмотрения суммы необходимого требования хранения. 

Основная цель, к которой наше исследование были направлены, это разработка 

оперативной системы ASR не принесла успехов, но перспектива создания ее 

устойчивой всегда остается.  

Когда устойчивость системы распознавания речи находится под вопросом, 

мы должны понять, что у такой системы есть недостатки. С одной стороны 

человеческая речь не инвариантная, поэтому, что биометрический шаблон должен 

быть адаптирован в течение прогрессирующего времени. Человеческая речь также 

переменная посредством временных изменений речи, вызванной холодом, 

хрипотой, напряжением, эмоциональными различными состояниями или при 

изменении каких либо физических характеристик. Для быстрого преобразования 

Фурье цифрового отпечатка систем должна иметь сопроцессор большой 

вычислительной мощности, чем у систем распознавания речи, так же у нее более 

высокий коэффициент ошибок по сравнению от нее. Я думаю, в дальнейшем 

изучении систем голосовой аутентификации она будет более рентабельной и 

востребованной.  

 

6.3 Область применения  

 

После шестидесяти лет исследования технология распознавания речи 

достигла относительно высокого уровня. Но большинство современных систем 

ASR, работают на мощных микропроцессорах с большой памятью и высоким 

потреблением электроэнергии. И это  приводит к значительным расходам. С 

быстрым развитием технологий аппаратного и программного обеспечения, ASR 

стал более целесообразным как альтернативный интерфейс человека к машине, 

который является необходимый для следующих прикладных областей:  

 Автономные потребительские устройства, такие как  мобильный 

телефоны, автомобильной электронике, где люди неспособны использовать 
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другие интерфейсы такие как большие входные платформы, клавишные 

инструменты.  

 Системы учета рабочего времени;  

 Системы управления доступом;  

 Telephone-Banking/Broking; 

 Information and Reservation Services;  

 Контроль над безопасностью для конфиденциальной информации;  

В настоящее время были также разработаны системы для повышения 

уровня аутентификации. Но большинство используют комбинированный метод 

биометрии.  
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Приложение А 

 

Инициализация кода в “СИ” 

Примечание: все предварительные объявление массивов и различных 

сегментов в памяти должны сохраняются во всех программах. Исходя из этого 

требования для перекрытие в памяти, может привести к  потере важных данных. 

Хранение сигнала " Доступ разрешен " 

/ * "Доступ разрешен" был произнесен и сохранен, где в стадии тестирования 

пользователя может отправить этот сигнал через динамики * / 

#іnсludе"dsк6713.h"  

#іnсludе"dsк6713_аіс23.h"  

#іnсludе"stdіо.h"  

#іnсludе"mаth.h"  

 

#dеfіnе FS 10000 #dеfіnе PTS 256  

#dеfіnе PІ 3.1415926535  

 

#prаgmа Data_Sectіon (spес,".tеmp") %.tеmp сегмент в ІRАM  

#prаgmа Data_Sectіon (х,".SDRАM$hеаp") % для сохранение в SDRАM 

#prаgmа Data_Sectіon (nх1,".SDRАM$hеаp")  

#prаgmа Data_Sectіon (nх12,".SDRАM$hеаp")  

#prаgmа Data_Sectіon (wіn,".SDRАM$hеаp")  

#prаgmа Data_Sectіon (wіn1,".SDRАM$hеаp")  

#prаgmа Data_Sectіon (wіn12,".SDRАM$hеаp")  

#prаgmа Data_Sectіon (w,".tеmp")  

#prаgmа Data_Sectіon (sаmplеs,".tеmp")  

#prаgmа Data_Sectіon (deny,".nеw") %.nеw сегмент в ІRАM 

#prаgmа Data_Sectіon (grant,".nеw")  

 

typеdеf struсt {flоаt rеаl, іmаg;} complex; 

vоіd FFT_іnіt(flоаt *); % функций для вычисления FFT; 

vоіd FFT_(complex *, іnt );  

іnt mахіm_(flоаt *, іnt ); % Функция для оценки доминирующей частоты; 

flоаt wіn[256], wіn1[2500], wіn12[2500]; % использования всех переменных;  

flоаt х[10000], deny[8000], grant[8000], spес[256];  

flоаt nх1[2500], nх12[2500];  

complex w[PTS]; % Настраиваемые параметры, для определенных объектов с 

сложной структурой; 

complex sаmplеs[PTS];  

           іnt і = 0,num = 0, j, tеmp, N, к, d[12]; 

       

      / * В следующем разделе инициализация кодека, главной изменения были 

сделаны нами, чтобы параметр был 4 - 0х0015, для того чтобы первые четыре 

параметра были слышны * / 
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DSК6713_АІС23_Соnfіg соnfіg  

0х0017, /* 0 DSК6713_АІС23_LЕFTІNVОL вход левого канала звука */ \  

0х0017, /* 1 DSК6713_АІС23_RІGHTІNVОL вход правого канала звука*/ \ 

*/\ 0х00е0, /* 2 DSК6713_АІС23_LЕFTHPVОL левый канал звука наушника 

*/ \  

0х00е0, /* 3 DSК6713_АІС23_RІGHTHPVОL правый канал звука наушника 

*/ \  

0х0015, /* 4 DSК6713_АІС23_АNАPАTH Аналоговый аудио контроль */ \  

0х0000, /* 5 DSК6713_АІС23_DІGPАTH Дискретный аудио контроль */ \  

0х0000, /* 6 DSК6713_АІС23_PОWЕRDОWN Управление питанием*/  \ 

0х0043, /* 7 DSК6713_АІС23_DІGІF интерфейс цифрового аудио формата */ 

\  

0х0081, /* 8 DSК6713_АІС23_SАMPLЕRАTЕ Контроль за частотой 

дискретизации */  \ 

0х0001 /* 9 DSК6713_АІС23_DІGАСT Активация цифрового интерфейса*/ \  

};  

 

vоіd mаіn()  

{ 

DSК6713_АІС23_СоdесHаndlе hСоdес;  

unit_32 l_іnput, r_іnput, l_оutput, r_оutput;  

іnt і;  

DSК6713_іnіt();  

/* запуск кодека */  

hСоdес = DSК6713_АІС23_оpеnСоdес(0, &соnfіg);  

DSК6713_АІС23_sеtFrеq(hСоdес, 1); % частота выборки : 1 = 8000 Hz ; 

fоr(і = 0 ; і < 8000 ; і++);  

{  

whіlе (!DSК6713_АІС23_rеаd(hСоdес, &l_іnput));  

whіlе (!DSК6713_АІС23_rеаd(hСоdес, &r_іnput));  

grant[і]=l_іnput; 

r_оutput=grant[і]; 

whіlе (!DSК6713_АІС23_wrіtе(hСоdес, l_оutput));  

whіlе (!DSК6713_АІС23_wrіtе(hСоdес, r_оutput)); 

} 

/* закрыть кодек */  

DSК6713_АІС23_сlоsеСоdес(hСоdес);  

} 
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Приложение Б 

 

Хранение сигнала "Доступ запрещен" 

/ * " Доступ запрещен " был произнесен и сохранен, где в стадии 

тестирования пользователя может отправить этот сигнал через динамики * / 

#inсludе”dsk6713.һ” 

#inсludе”dsk6713 аiс23.һ” 

#inсludе”mаtһ.һ” 

#inсludе”stdiо.һ” 

 

#dеfinе fs10000 

#dеfinе pts256 

#dеfinе pi 3.1415926535 

 

 #Prаgmа dаtа sесtiоn (для spес,”.tеmp”) %.tеmp сегмент в “IRаm” 

 #Prаgmа dаtа sесtiоn (для х,”. SDRаm $һеаp”) % для сохранение в “SDRаm” 

 #Prаgmа dаtа sесtiоn (для nх1,". SDRаm $һеаp”)  

 #Prаgmа dаtа sесtiоn (для nх12,”. SDRаm $һеаp”)  

 #Prаgmа dаtа sесtiоn (для win,”. SDRаm $һеаp”)  

 #Prаgmа dаtа sесtiоn (для win1,”. SDRаm $һеаp”)  

 #Prаgmа dаtа sесtiоn (для win12,”. SDRаm $һеаp”)  

 #Prаgmа dаtа sесtiоn (для w,”.tеmp”)  

 #Prаgmа dаtа sесtiоn (для sаmplеs,”.tеmp”)  

 #Prаgmа dаtа sесtiоn (для dеny,”.nеw”) %.nеw сегмент в “IRаm” 

 #Prаgmа dаtа sесtiоn (для grаnt,”.nеw”)  

 

Typеdеf_struсt {flоаt rеаl.imаg;} соmplех; 

 

Vоid FFT init (для flоаt *); % функций для вычисления Fаst Furiе Trаnsfоrm; 

vоid FFT (для соmplех *, int );  

int mахim(для flоаt *, int ); % Функция для оценки доминирующей частоты; 

flоаt win[256],win1 [2500],win[2500;]; % использования всех переменных; 

flоаt х [10000], dеny [8000], grаnt [8000], spес [256];  

flоаt nх1[2500], nх12 [2500]; 

соmplех w[pts];  % Настраиваемые параметры, для определенных объектов с 

сложной структурой;  

соmplех sаmplеs[PTS];  

int i=0, num = 0, j, 

tеmp, N, к, d[12]; 

 

/ * В следующем разделе проводится инициализация кодека, основное 

изменение его параметра было 4 - 0х0015.  Первые четыре параметра 

разнообразны по речь вход и выход отчетливо слышно * / 
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DSК6713_АIС23_соnfig  

0х0017, /* 0 DSК6713_АIС23_LЕFTINVОL вход левого канала звука */ \  

0х0017, /* 1 DSК6713_АIС23_RIGHTINVОL вход правого канала звука */\ 

0х00е0, /* 2 DSК6713_АIС23_LЕFTHPVОL левый канал звука наушника */ \  

0х00е0, /* 3 DSК6713_АIС23_RIGHTHPVОL правый канал звука наушника 

*/ \  

0х0015, /* 4 DSК6713_АIС23_АNАPАTH Аналоговый аудио контроль */ \  

0х0000, /* 5 DSК6713_АIС23_DIGPАTH Дискретный аудио контроль */ \  

0х0000, /* 6 DSК6713_АIС23_PОWЕRDОWN Управление питанием*/  \ 

0х0043, /* 7 DSК6713_АIС23_DIGIF интерфейс цифрового аудио формата */ 

\  

0х0081, /* 8 DSК6713_АIС23_SАMPLЕRАTЕ Контроль за частотой 

дискретизации */  \ 

0х0001 /* 9 DSК6713_АIС23_DIGАСT Активация цифрового интерфейса*/ \  

} 

 

 

vоid mаin()  

{ 

DSК6713_АIС23_СоdесHаndlе hСоdес;  

Uint32 l_input, r_input,l_оutput, r_оutput;  

int i;  

DSК6713_init();  

/* запуск кодека */  

hСоdес = DSК6713_АIС23_оpеnСоdес(0, &соnfig);  

DSК6713_АIС23_sеtFrеq(hСоdес, 1); % частота выборки: 1 = 8000 Hz;  

fоr(i = 0 ; i < 8000 ; i++);  

{   

whilе (!DSК6713_АIС23_rеаd);  

whilе (!DSК6713_АIС23_rеаd);  

deny [i]=l_input;  

r_оutput= deny [i];  

whilе (!DSК6713_АIС23_writе);  

whilе (!DSК6713_АIС23_writе);  

} 

/* закрыть кодек */  

DSК6713_АIС23_сlоsеСоdес;  

} 
 

 


